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Preface

About this Manual This guide explains how to use the ERDAS APOLLO single-installer 
system to install a basic, working instance of the following components 
of the ERDAS APOLLO system.

• ERDAS APOLLO Server (Advantage/Professional edition - 
includes the Web Client)

• ERDAS APOLLO Server (Essentials-SDI edition - includes the 
Web Client))

• ERDAS APOLLO Data Manager

Documentation This manual is part of a suite of online documentation that you receive 
with ERDAS APOLLO software. There are two basic types of 
documents, digital hardcopy documents which are delivered as PDF 
files suitable for printing or online viewing, and Online Help 
Documentation, delivered as HTML files.

The PDF documents are found in <APOLLO_HOME>\help\hardcopy. 
Access the online help system from the Help drop-down menu in the 
application.

• The Installation and Configuration Guide provides instructions 
for installing a basic, working ERDAS APOLLO system, as well as 
instructions for upgrading or replacing an older system.

• The Data Manager Guide provides instructions for the ERDAS 
APOLLO Data Manager, which is the ERDAS APOLLO system 
component that you will be using to create and manage your 
imagery catalog and/or service providers.

• The User Guide gives instructions on using the ERDAS APOLLO 
Web Client and instructions on using HTTP requests to interact with 
your ERDAS APOLLO Server.

• The ERDAS APOLLO Administrator’s Guides contain instructions 
for advanced installation, configuration, and optimization of the 
server component of ERDAS APOLLO. There are two books that 
cover this material:

• ERDAS APOLLO Administrator’s Guide 
(Advanced/Professional edition) provides information about 
the features that are unique to that level of the product, such as:
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- The ERDAS APOLLO Imagery Catalog
- Clip, Zip, and Ship image downloading
- Geoprocessing (WPS)

• ERDAS APOLLO Administrator’s Guide 
(Essentials-SDI edition) provides information about how to 
create and configure OGC-compliant service providers, how to 
use the different tools and utilities available in ERDAS APOLLO 
to help you work with your data, and how to use ERDAS 
APOLLO Style Editor.

Document 
Conventions

In ERDAS APOLLO, the names of menus, menu options, buttons, and 
other components of the interface are shown in bold type. For example:

“In the Select Layer To Add dialog, click the Fit to Frame option.”

When asked to use the mouse, you are directed to click, double-click, 
Shift-click, middle-click, right-click, hold, drag, etc.

• click — click once with the left mouse button.

• double-click — click twice with the left mouse button.

• Shift-click — hold down the Shift key on your keyboard and 
simultaneously click the left mouse button.

• middle-click — click once with the middle mouse button.

• right-click — click once with the right mouse button.

• hold — press and hold the left (or right, as noted) mouse button.

• drag — drag the mouse while holding the left mouse button.

The following paragraphs are used throughout the ERDAS APOLLO 
documentation:

These paragraphs contain strong warnings or important tips.

These paragraphs direct you to the ERDAS IMAGINE  software function 
that accomplishes the described task.

These paragraphs lead you to other areas of this book or other 
manuals for additional information.

®



Preface 3

These paragraphs provide information about Erdas products.

NOTE: Notes give additional instruction.

Because you can choose where to install a program, the install folder is 
referred to <APPNAME_HOME>, where APPNAME represents the 
name of the program.

Flag Box
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Installation and Configuration
This chapter includes information on how to install and configure 
ERDAS APOLLO.

System 
Components

An ERDAS APOLLO system includes a server computer and one or 
more client computers. Install the Server Installation on the server and 
the Data Manager on the client computers. The third part of the system 
is a database. APOLLO supports three databases: Oracle, Postgre 
SQL, and MS SQL Server 2008.

Server The server installation includes the following. 

• ERDAS APOLLO Server 64-bit or 32-bit (Professional, 
Advantage, or Essentials)

• compatible application server (Tomcat included with Essentials 
and JBoss included with Advantage/Professional, Weblogic - 
you must install)

• Java Development Kit (JDK) 6.0 Update 20

• Apache Load Balancer (Windows only)

• ERDAS Native Core Raster Support

• IWS (Advantage/Professional Windows only)

If you select the bundled application server during installation, the 
installer also installs, configures, and deploys the ERDAS APOLLO 
Applications(s) into the application server.

There are three levels of the ERDAS APOLLO Server.

• Professional - add, edit, or retrieve data from an imagery data 
catalog, create and manage service providers, and work with 
geospatial processes.

• Advantage - add, edit, or retrieve data from an imagery data 
catalog and create and manage service providers.

• Essentials-SDI - create and manage service providers

Weblogic To use Weblogic, you must install, configure, and deploy it. Refer to the 
WebLogic chapter for complete instructions.
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Data Manager The ERDAS APOLLO Data Manager installation is a separate, stand-
alone installer.The ERDAS APOLLO Data Manager interacts with any 
level of the ERDAS APOLLO Server. This includes the Java Runtime 
Environment (JRE) 6.0 Update 20. 

Database Create a database and a user account that the installer can use to 
access the database so it can create the necessary tables. 

Follow the rules established by the database platform when you 
create the password for your “master” user account. 

Do not include the dollar sign ($) in the database password. 

You need the following information from the database for the Server 
installation.

• name of the database server

• listener port number

• SID/Database Name

• catalog user name

• catalog user password

Oracle

If you are using an Oracle database, create a user who owns the 
catalog schema. Grant this user the "connect", "resource", and “Create 
View” roles and the “create view” and “analyze any” system privilege. 
The “connect” and “resource” roles have to be set as "default" roles (for 
TOAD users).

PostgreSQL

You must have a working PostGIS database in your PostgreSQL 
instance. You can create a PostGIS database at installation time or 
later using the template 'template_postgis'. Set up a user who has 
permission to create database objects and has a schema in the 
PostGIS database. The installation asks for the credentials of this user 
and the database administrator (usually 'postgres'), the actual database 
name, and the port number.
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Microsoft SQL Server

Inside your SQL Server instance, you need to create the following.

• log in with all server roles enabled

• user account that is associated with that login. 
The user should be a member of all the database roles

• blank database for ERDAS APOLLO that is owned by that user 
account.

Also enable XA transactions. Microsoft provides instructions for that in 
their SQL Server Developer Center, on the following web site.

http://msdn.microsoft.com/en-us/library/aa342335.aspx

If you install this ERDAS APOLLO system as a replacement for an 
older ERDAS APOLLO system, see Upgrade on page 3 before 
you begin.

ERDAS-Net Licensing You must install ERDAS-Net Licensing on the same computer as your 
ERDAS APOLLO Server and configure it with valid licenses. 

For more information see the Erdas-Net Licensing chapter.

If you need additional assistance with licensing, e-mail 
teamlicensing@erdas.com

Antivirus Software 
Requirements

If you are using antivirus software that features real-time protection and 
it is scanning your geospatial data files or your ERDAS APOLLO 
installation folder, it may cause your ERDAS APOLLO system to be 
unreasonably slow. 

For best results, create an “exception rule” that excludes the data files 
and the installation folder from the scanning of the real-time protection 
feature.

Upgrade When you upgrade your ERDAS APOLLO installation, make a copy of 
all the files in the installation folder or folders for your previous products, 
AND your ERDAS APOLLO database or databases.

http://msdn.microsoft.com/en-us/library/aa342335.aspx
teamlicensing@erdas.com
../hardcopy/cg_shared/FLEXnet_Licensing.pdf
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• The installer upgrades your database schema so that it is 
compatible with the new version of ERDAS APOLLO. For Oracle, 
you must add the "create view" system privilege to the schema. 

• The installer places a link in the database that allows ERDAS 
APOLLO to locate your existing thumbnails and ISO metadata files. 

• Any thumbnails and ISO metadata files that are created by ERDAS 
APOLLO will be stored in the folder specified in the 
global.server.properties file. 

• (See "Centralization of Metadata, Thumbnails, Pyramids, and WPS 
Outputs" in the ERDAS APOLLO Administrator's Guide: 
Advantage/Professional Edition for more information).

• Make sure the customizations you made to your older product are 
applied to your new product. Follow the instructions for existing 
ERDAS APOLLO users in the section, After Installation on page 
19 of this guide.

Stop an Application 
Server

The procedure for doing this varies depending on what kind of 
application server you are using. 

JBoss application server

1. Open the Control Panel.

2. Select Administrative Tools > Services

3. Find JBoss Application Server 4.2 in the grid, right-click it, 
and select Stop in the menu.

Apache Tomcat application server

If Apache Tomcat is running as a Windows service:

1. Open the control panel.

2. Select Administrative Tools > Services

3. Find Apache Tomcat in the grid, right-click it, and select Stop 
in the menu.

If Apache Tomcat was not running as a Windows service:

1. Go to the open command line window that was used to start the 
startup.bat file and press Ctrl-C on the keyboard or close the 
command line window.

WebLogic application server
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1. Click the Windows Start button.

2. Click All Programs.

3. Select Oracle > Weblogic > User Projects > apollo_domain 
> Stop Admin Server.

4. A command line window will open. 
Enter the user name weblogic and the password weblogic1 
to log in to the domain.

Uninstall a Windows 
Service

JBoss Windows service

1. Open a command line window.

2. Navigate to the <JBOSS_HOME>/bin folder.

3. At the prompt, type service.bat uninstall and press Enter.

Apache Tomcat Windows service:

1. Open a command line window.

2. Navigate to the <TOMCAT_HOME>/bin folder.

3. At the prompt, type service.bat remove and press Enter.
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Server Installation 
- Windows

This installation program installs any version of ERDAS APOLLO 
Server. You will only be able to run the version for which you have a 
valid license.

1. Insert the ERDAS Software DVD and the ERDAS Master Installer 
Autorun dialog opens. 

2. Click ERDAS APOLLO.

3. Select Install ERDAS APOLLO version Server in the Installation 
Options list. The Introduction dialog opens.

4. Read the instructions and click Next. A Warning message reminds you 
to read this guide.

5. Click OK and the ERDAS APOLLO License Agreement dialog opens.

6. Read the agreement and then click I Accept the terms of the License 
Agreement. 

7. Click Next and the Select ERDAS APOLLO product tier to install dialog 
opens.

8. Select one of the server installations. Click Next.
If you have a 64-bit machine, the Select System Architecture dialog 
opens.
OR
If you do not have a 64-bit machine, continue with step 12.

9. Select 32-bit or 64-bit capability.

10. Click Next.

11. The Select Install Type dialog opens.

• Standalone - one server and one database

• Create New Cluster - a group of servers on different computers 
that share incoming requests from ERDAS APOLLO Data 
Manager and ERDAS APOLLO Web Client users so that your 
system can handle a higher user volume and even larger 
requests. This system includes a load balancer that receives 
requests and assigns the request to a server. If the server fails, 
the load balancer requests reauthentication from the user and 
then reassigns the request to a different server. Be sure to enter 
the Load balancer host and port number later in this installation.

• Add to Existing Cluster - you can add servers to an existing 
cluster
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12. Choose your system, click Next, and the Choose Local Install Directory 
dialog opens. 

13. Click Choose to browse to and select a different install folder.

OR

Click Restore Default Folder to return the install folder to the default 
setting (C:/ERDAS/APOLLOversion).

Make sure the shared location is accessible over the network (with 
READ/WRITE access for every computer that runs on a cluster 
node) for the user account that will be set as impersonation on the 
JBoss/Weblogic service. 

Do not use a folder name with spaces. 

Do not install the ERDAS APOLLO products in the same folder as 
the application server.

OR

Click Next.

If you are installing a standalone system, the Choose shortcut folder 
dialog opens. Continue with step 15.
OR
If you are installing a Cluster, the Choose Shared Install Directory 
dialog opens.

14. Choose the folder to install shared configuration and resource files for 
the cluster. Use the full UNC path to the location; do not use a mapped 
network drive. The Choose shortcut folder dialog opens.

15. Choose the method to launch ERDAS APOLLO and click Next. The 
Install Sample Data? dialog opens.

16. The Sample Data is approximately 100 MB. If you do not need sample 
contexts and services, do not install the sample data.

17. Select the type of database to connect to the server.

• Oracle 10g/11g

• Postgres

• SQL Server
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The Database Info dialog opens.

18. Enter the Database Info settings. 

Server server where the database is located

Port listener port number (default is set to 1521)

SID/Database Name  database server ID

Catalog User Name database user name

Catalog User Password database user password

19. Click Next. If you are setting up a cluster, the Enter Clustering Setup 
Details dialog opens. Otherwise, continue with step 22.

20. Enter Cluster Setup Details. 

Node Name  name of the cluster computer. This must be an alias to 
the current node, and is mainly used for sticky session setup in the 
cluster. The cookie named "JSESSIONID" will have this "Node Name" 
value appended to its value.

Load Balancer Host  name or IP address of the computer (load 
balancer) on which Apache httpd is installed

Load Balancer Port port number that the load balancer is using. (If 
you accepted the default settings when you installed Apache httpd, it is 
using port 80.)

Cluster Multicast Address IP address of the cluster. The default 
cluster multicast address is 230.0.0.1. Use the default address unless 
you are installing multiple clusters on your network. If you have multiple 
clusters, make sure each cluster has a unique IP address. The 
multicast address is used in two places.

• To synchronize the nodes in the cluster (for JBoss it is in cluster-
service.xml) used by Jgroups configuration of JBoss cluster 
setup.

• Used by distributed ehcache, which is used for both Hibernate 
second level cache and the configuration setup.

This information tells each ERDAS APOLLO Server node how to 
connect to the cluster. Use the same Host, Port, and Address each 
time you run the installer to set up another node. 
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Syslog Daemon Host URL of the tool (syslog daemon) that 
consolidates the logs from all nodes. (default is localhost) This tool 
simplifies troubleshooting.

Syslog Daemon Port port number of the syslog daemon that 
consolidates the logs from all nodes. (default is 514)

21. Click Next.

22. If you are installing a cluster, JBoss is automatically installed. Continue 
with step 24.

OR

If you are installing a stand-alone system, then the Select Application 
Server dialog for your version opens.

23. Essentials SDI is compatible with the following application servers.

• Apache Tomcat 6.0 (bundled) - included in the installer

• JBoss (bundled) - included in the installer

• WebLogic - you must install and configure

• Generic - use for any application server not listed - you must 
install and configure

Advantage/Professional is compatible with the following application 
servers.

• JBoss - included in the installer

• WebLogic - you must install and configure

24. Click Next and the HTTP Server Settings dialog opens.

25. Enter the hostname and port number.

HTTP Server Hostname name of the computer on which you are 
installing ERDAS APOLLO Server or the static IP address of that 
computer

HTTP Server Port  port number used to access the service. The 
default server port number is 80. 

Application Server Admin Port use the default port number unless 
you need to avoid a conflict with a another server or service
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26. Click Next and If you selected Advantage/Professional the SMTP 
Settings dialog opens. Otherwise, continue with step 28.

27. The Simple Mail Transfer Protocol (SMTP) is required for APOLLO 
Professional and defines the location to send e-mails. For other 
versions, continue with step 29.

SMTP Hostname

SMTP Port

SMTP User

NOTE: Windows Firewall and other antivirus programs may block 
outgoing e-mail. Add your application server to the list of applications 
allowed to send e-mail from the server. 

28. Click Next and the Create Windows Service dialog opens.

29. There are two Windows services required for APOLLO: Apache HTTP 
(load balancer) and JBoss. 

Click Yes to install a Windows service.

OR

Click No if you have multiple copies of APOLLO and do not need to 
install the Windows services again.

The Bing Maps panel opens.

30. Select one of the Bing Maps options. You must obtain a Microsoft Bing 
Maps key under agreement with Microsoft if you intend to use this 
option externally. You can change this setting after installation through 
the bingmaps.key parameter of the apollo-client.properties file.

Do not enable Microsoft Bing Maps

Enable Microsoft Bing Maps for internal use

Eanable Microsoft Bing Maps for external use - Please provide 
user key

The Preinstallation Summary dialog opens.

31. Review the summary and click Install when ready. The Installing 
ERDAS APOLLO dialog opens. The installation process takes several 
minutes. Several dialogs and messages display during installation. The 
Install Complete dialog indicates the process has completed.
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If you selected to set up services, a dialog prompts you to reboot to 
update the created services.

Server Installation 
- Linux - 
Essentials-SDI 

The following instructions explain how to install ERDAS APOLLO 
Server (Essentials-SDI) on a Linux computer in console mode.

You can also install ERDAS APOLLO Server (Essentials-SDI) on a 
Linux machine using the graphical user interface for Linux. If you use 
the graphical interface for Linux, the installation steps are basically the 
same as the ones for installing ERDAS APOLLO Server on a Windows 
computer.

ERDAS APOLLO Server (Advantage/Professional) cannot run on 
Linux. If you need to install the Advantage or Professional levels of 
the ERDAS APOLLO Server, see Server Installation - Windows 
on page 6.

1. Open a console (local or Telnet/SSH) then start the installer using the 
command sh install.bin -i console. The i console option 
indicates that you are running the installer in the console mode. 

NOTE: Use the chmod u+x command on the install.bin file to be 
able to execute it. 

NOTE: The installer requires sufficient temp space while executing. You 
can either clean up your default temp folder (typically the default temp 
directory is /tmp) or set the environment variable IATEMPDIR using the 
export command. For example, export 
IATEMPDIR=/your/temp/space/directory.

Introduction

2. Press Enter to continue. A warning message reminds you to read the 
Quick Start Guide. 

You can cancel the installation at any prompt by entering “quit”.

You can change an entry in a previous step by entering “back”.

3. Press Enter. The Licence Agreement begins. The console displays the 
license agreement in several parts, press Enter after each part to 
continue reading the agreement.
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DO YOU ACCEPT THE TERMS OF THIS LICENSE AGREEMENT? 
Y/N

4. Type Y to continue with installation. 

Choose Product to Install

5. Press Enter to accept the default (Essentials).

Get User Input

6. You can set up a standalone system or a cluster. Enter any number of 
1,2, or 3 or press Enter to accept the default (Standalone).

Choose Local Install Folder

ENTER AN ABSOLUTE PATH, OR PRESS <ENTER> TO ACCEPT 
THE DEFAULT

7. Enter the full path for the installation or press Enter to accept the default 
(/user/local/erdas/)APOLLOversion.

INSTALL FOLDER IS: /usr/local/erdas/ERDAS/APOLLOversion IS 
THIS CORRECT? (Y/N)

8. Type Y to continue.

Choose Link Location

9. Choose the location of the links to the application.

Install Sample Data?

10. The Sample Data is approximately 100 MB. If you do not need sample 
contexts and services, do not install the sample data.

Choose a type of database to link to your installation

11. Enter the number corresponding to database you set up for APOLLO.

1 - Oracle: Oracle connection and modules tests

2 - PostgreSQL: PostgreSQL connection tests

3 - SQL Server: Database Settings - Database host

12. For any database, enter the computer name on which the database is 
installed. 

Enter the port of the database server
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13. Enter the port number for the database server of press Enter to accept 
the default for the database.

Enter the SID of the database server

14. Enter the database server ID or accept the default.

Enter the database Catalog user name 

15. Enter database user name.

Enter the database Catalog user password 

16. Enter database user password. You cannot use a dollar sign ($).

Essentials SDI - Select Application Server if you installing a 
standalone system. 

17. Select the application server to use with Essentials - SDI.

Configure Server Host - Server Hostname

18. Enter the server host computer name or the IP address.

Tomcat and JBoss: Server Port

OR

All other configurations, continue with step 22.

19. Enter the port number of the server.

Tomcat: Admin Port 

JBoss: continue with step 22.

20. Enter the port number used to manipulate Tomcat remotely.

The Bing Maps panel opens.

Do not enable Microsoft Bing Maps

Enable Microsoft Bing Maps for internal use

Eanable Microsoft Bing Maps for external use - Please provide 
user key
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21. Select one of the Bing Maps options. You must obtain a Microsoft Bing 
Maps key under agreement with Microsoft if you intend to use this 
option externally. You can change this setting after installation through 
the bingmaps.key parameter of the apollo-client.properties file.

Pre-installation Summary - Please review the following before 
Continuing

22. Press Enter to continue with the installation. Wait for the message 
ERDAS APOLLO version has been successfully installed to 
installdirectory.

Deployment

Adv/Pro - JBoss If you selected JBoss as your application server while you were running 
the ERDAS APOLLO Server installer, JBoss has already been installed 
on your server and ERDAS APOLLO Server has been deployed for 
you. You must reboot the server after installation to start the JBoss 
service.

The server installation includes install_services and uninstall_services 
batch files. The installation runs the install_services batch file.

If you are using a mapped network drive for crawling, be sure to log in 
and run JBoss with the same user as the machine running the Data 
Manager. Otherwise, the mapped network drive will not appear as one 
of the drives available for browsing in the Data Manager Browse dialog.

Essentials-SDI 
Deployment

If you select Apache Tomcat or JBoss as your application server when 
you install ERDAS APOLLO Server (Essentials-SDI), the installer 
automatically installs your application server and deploys ERDAS 
APOLLO Server. After your installation is complete, start ERDAS 
APOLLO Server by doing one of the following:

• reboot your computer 

• install JBoss or Apache Tomcat as a Windows service and start 
the service 

Apache Tomcat 5/6

Before you can connect with the Data Manager, open the tomcat-
users.xml file and add the following lines.

<role rolename=”esp_adminstrator”/>



Installation and Configuration 15

<user username=”admin” password=”apollo123” 
roles=”esp_admisntrator”/>

Apache Tomcat 5

To deploy ERDAS APOLLO Server on Apache Tomcat 5 follow these 
basic steps then you can start Apache Tomcat.

Copy the ERDAS APOLLO Server Web ARchive (WAR) files from the 
folder where you installed ERDAS APOLLO Server and place them in 
the folder where you installed Apache Tomcat.

1. Open the <APOLLO_HOME>\dist folder.

2. Copy the files apollo-client.war and erdas-apollo.war.

3. Open the <TOMCAT_HOME>\webapps folder and paste the files you 
just copied into it.

Increase the memory settings for Apache Tomcat.

1. Open the <TOMCAT_HOME>/bin folder. 
If you are installing ERDAS APOLLO Server on a Windows 
machine, find the file named catalina.bat.
If you are installing ERDAS APOLLO Server on a machine with a 
UNIX-based operating system, find the file named catalina.sh.

2. Open the catalina file for editing.

3. If you are installing on Windows, add the following line at the 
beginning of the file:

If you are installing on a UNIX-based operating system, add:

To install Apache Tomcat as a Windows service and start the service 
follow these instructions.

1. Open a command line window.

2. Navigate to the <TOMCAT_HOME>/bin folder.

set JAVA_OPTS=%JAVA_OPTS% -Xms512m -Xmx512m -XX:PermSize=128m -
XX:MaxPermSize=256m

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx512m -XX:PermSize=128m -XX:MaxPermSize=256m"
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3. At the prompt, type service.bat install and press Enter.

4. Open the Windows Services by opening your Windows Control 
Panel and selecting Administrative Tools > Services.

5. Right-click Apache Tomcat in the list of services and select 
Properties on the menu that appears. The Apache Tomcat 
Properties dialog box opens.

6. Change the Startup type to Automatic if you want the application to 
start automatically when Windows starts.

7. Click the Start button under the Service status field. The Service 
status should change to Started.

8. Close the Apache Tomcat Properties dialog box and the Services 
window.
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WebLogic

To deploy ERDAS APOLLO Server (Essentials-SDI) on WebLogic, you 
first need to install and configure WebLogic using the instructions in the 
sections Installation on page 54 and Configuration - Essentials-SDI 
on page 69. 

NOTE: It is assumed that ERDAS APOLLO Server will be deployed in 
a fresh new domain. Deployment of ERDAS APOLLO Server in an 
existing domain will also work provided it has been configured with the 
requirements of the product. 

To deploy ERDAS APOLLO Server on WebLogic:

1. Open the WebLogic Administration Console.

2. In the domain structure tab on the left, choose Deployment.

3. Click the Install button. 

4. Navigate to the <APOLLO_HOME>\dist\weblogic folder and click 
on the Next button.

5. Choose to install the deployment as an application and click on the 
Next button.

6. In the Security configuration, choose the Custom Roles option and 
click the Finish button.

After you have deployed ERDAS APOLLO Server, you need to start it.

To start ERDAS APOLLO Server:

1. Click on the Activate Changes button which will redirect you to the 
list of applications installed on the server.

2. In the list, check the ERDAS APOLLO Server application (ERDAS 
APOLLO Server by default).

3. Click on the Start button, then click Servicing all requests. 
Confirm your selection in the next screen

Testing Your 
Installation

The ERDAS APOLLO products come with a web tools welcome page 
that is installed and published when you install any version of the 
ERDAS APOLLO Server.
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If you have successfully installed the product, you will see the welcome 
page when you visit the following web address

http://<server_name>:<portnumber>/erdas-apollo.

Data Manager 
Installation

After you have installed the ERDAS APOLLO Server and you have 
verified that it is running, install the ERDAS APOLLO Data Manager. 
Install ERDAS APOLLO Data Manager on one or more separate 
computers that have a network connection to the ERDAS APOLLO 
Server computer.

1. Insert the ERDAS Software DVD into your DVD drive.
The ERDAS Master Installer Autorun dialog opens.

2. Click ERDAS APOLLO.

3. Select Install ERDAS APOLLO Data Manager in the installation 
options list.

The installer has to prepare for the installation procedure. This can 
take a few minutes. When ready, the ERDAS APOLLO Data 
Manager - Introduction dialog opens.

4. Click Next and the License Agreement dialog opens. 
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5. Accept the License Agreement and click Next. The Choose Install 
Folder dialog opens.

6. Click Choose to browse to and select a install locations
OR
Click Next to accept the default install location. 
The Choose Shortcut Folder dialog opens.

If a version of the ERDAS APOLLO Data Manager is already 
installed in that folder, it will be uninstalled.

7. Choose one of the locations for the shortcut. You can also choose 
to create icons for just for the Windows user who is currently logged 
in or for all of the people who have Windows users accounts on that 
computer.

8. Click Next and the Pre-Installation Summary dialog opens.

9. Review the summary and then click Install to begin the installation. 
Several messages display and the Install Complete dialog signifies 
that the installation has successfully completed.

10. Click Done to exit the installation.

After Installation 
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If you were using a previous version of ERDAS APOLLO, follow the 
appropriate instructions for the upgrade. If you have a new version, you 
can begin using the product.

Upgrade from 9.3.x/2010 
to 2011 

If you are upgrading from 9.3.x/2010, complete the appropriate tasks for 
your installation.

• ERDAS APOLLO Image Manager - complete Keeping Your 
Existing Customizations on page 24 immediately after you 
complete installation. 

• ERDAS APOLLO Server - complete Migrating Service Providers 
on page 20 and Keeping Your Existing Customizations on page 
24 immediately after you complete installation.

• ERDAS APOLLO Server and ERDAS APOLLO Image Manager - 
complete Migrating Service Providers on page 20, Migrating 
Data on page 23, and Keeping Your Existing Customizations on 
page 24 immediately after you complete installation. 

If you are upgrading from 2010.x, complete the following tasks for your 
installation

• Complete Migrating Service Providers on page 20 and Keeping 
Your Existing Customizations on page 24 immediately after you 
complete installation.

Migrating Service Providers

The service providers in your previous ERDAS APOLLO Server are not 
automatically moved into your new ERDAS APOLLO. If you want to use 
your existing service providers, use the Service Provider Migration 
Tool. 

The service provider migration tool is a simple command line tool. You 
provide a path to the location of the existing service providers and a 
path to the new location. 

When the tool runs, it reads the definitions for your existing service 
providers from the following files in your ERDAS APOLLO Server 
installation folder (<OLD_APOLLO_HOME>): 

• <OLD_APOLLO_HOME>/config/erdas-apollo/providers/coverage/ 
providers.fac

• <OLD_APOLLO_HOME>/config/erdas-apollo/providers/map/ 
providers.fac
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• <OLD_APOLLO_HOME>/config/erdas-apollo/providers/vector/ 
providers.fac

It copies the definitions from each file into a corresponding file named 
migrated.fac. Any paths that are copied into migrated.fac that point 
to a location in the ERDAS APOLLO Server installation folder are 
automatically converted so that they point to the corresponding location 
in the ERDAS APOLLO folder. All other paths are copied "as is".

These migrated.fac files are then placed in the following directories 
in your new ERDAS APOLLO folder, alongside your new providers.fac 
files:

• <APOLLO_HOME>/config/erdas-apollo/providers/coverage

• <APOLLO_HOME>/config/erdas-apollo/providers/map

• <APOLLO_HOME>/config/erdas-apollo/providers/vector

The service provider migration tool also copies the configuration files 
that are located in the folder <ERDAS APOLLO 
Server_HOME>/config/erdas-apollo/storage and places the copies in 
<APOLLO_HOME>/config/erdas-apollo/storage.

The styles for vector providers are copied to the new installation. The 
styles for coverage service providers are not copied.

For coverage providers, the index files in GML for the index and list 
providers are copied but the dataset paths contained in those files are 
copied “as is”. If you move the datasets, you will need to edit the index 
files and change the paths.

For map providers, the image provider definitions are copied into 
<APOLLO_HOME>/config/erdas-apollo/providers/coverage/
migrated.fac. The other provider definitions (proxy, portray, ArcSDE 
raster, pyramid, context, ...) are copied into 
<APOLLO_HOME>/config/erdas-apollo/providers/map/
migrated.fac. Any paths that are copied into migrated.fac that point to 
a location in the ERDAS APOLLO Server installation folder are 
automatically converted so that they point to the corresponding location 
in the ERDAS APOLLO folder. All other paths are copied "as is".

The migration tool will not copy any of the sample service providers that 
are included with your ERDAS APOLLO Server. ERDAS APOLLO 
contains sample providers, however. Your ERDAS APOLLO installer 
gives you the option to install these files when the product is installed.

The migration does not affect any of the service providers that you may 
have already created in ERDAS APOLLO.
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To use the service provider migration tool:

1. Open a command line window.

2. Navigate to the folder <APOLLO_HOME>/tools/provider-migrator.

3. At the prompt, type 
runmigrate <source_path> <targetpath> -v

<source_path> = ERDAS APOLLO Server old home folder
<target_path> = ERDAS APOLLO home folder
-v is a command that tells the tool to display information about what 
it is doing. This command is optional, but recommended.
You must use the correct case when specifying the path.

If the paths contain blank spaces, enclose them in quotation 
marks.

4. Press Enter.

After you run the service provider migration tool, you need to:

1. Copy the legend icons and thumbnails located in 
<OLD_APOLLO_HOME>/config/erdas-apollo/legend and place the 
copies in <APOLLO_HOME>/storage/legend.

2. Copy the metadata files located in 
<OLD_APOLLO_HOME>/config/erdas-apollo/metadata and place 
the copies in <APOLLO_HOME>/storage/metadata.

3. If you have been storing your data inside <OLD_APOLLO_HOME> 
you need to move the data to the corresponding folder inside 
<APOLLO_HOME>, or you need to change the paths to the data 
inside the migrated.fac files.

4. Test your old service providers in APOLLO to make sure they work 
as expected.

If they do not, you should first check the definition for that provider 
in the migrated.fac file to make sure the paths to the data are 
accurate. 

If the service providers are still not working properly, or if you have 
some other reason to believe that the migration failed, you can 
delete the migrated.fac files in the <APOLLO_HOME>/config 
erdas-apollo/providers folder and run the service provider migration 
tool again. The tool may display messages to indicate that some of 
the target directories already exist, but the tool will perform all of the 
migration tasks again.
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Migrating Data 

If you are upgrading to ERDAS APOLLO from a single ERDAS 
APOLLO product (ERDAS APOLLO server, ERDAS APOLLO Image 
Manager, or ERDAS APOLLO 2010.x), then the installer has already 
connected ERDAS APOLLO to your existing APOLLO database and 
upgraded it.

If you are upgrading to ERDAS APOLLO and you were using both 
ERDAS APOLLO Server and ERDAS APOLLO Image Manager (EAIM) 
before, you should have the installer connect to your existing EAIM 
database and upgrade it. This will serve as the database for ERDAS 
APOLLO. You can then migrate the data from your ERDAS APOLLO 
Server database into the upgraded database that you are using for 
ERDAS APOLLO.

Even after your EAIM 9.3.2 database is upgraded to ERDAS 
APOLLO, the pyramid paths within it are still set for the 9.3.2 
version, and are still pointing to the absolute 9.3.2 installation 
location (unless you customized your EAIM 9.3.2 installation to 
store the pyramids outside the <EAIM932_HOME>folder).

You need to move your pyramids out of the 
<EAIM932_HOME>folder and upgrade these paths in the 
database before you uninstall EAIM 9.3.2 version, or you will lose 
your existing pyramids. ERDAS provides a script for Oracle users 
to make this task easier. Contact your support representative.

To migrate information from your ERDAS APOLLO Server 9.3.2 
database to your ERDAS APOLLO database:

1. Make sure that ERDAS APOLLO Server is running.

2. Open your internet browser and go to the URL
http://<host>:<post>/apollo-catalog/rest/
services.txt?maxresults=1000

Where:
<host> is the name of the computer on which ERDAS APOLLO 
Server is installed 
<port> is the HTTP port for the application server used by 
ERDAS APOLLO Server 9.3.2

3. This URL will return a list of service URLs.
Save the file from your browser in the 
<APOLLO_HOME>/tools/harvester-console folder as 
services.txt.
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4. Open a command line window.

5. Navigate to the <APOLLO_HOME>/tools/harvester-console 
folder.

6. At the prompt, type edit build.properties and press Enter.
An editor will open inside the command line window and the 
contents of the file build.properties will be shown inside the 
editor.

7. Check the catalog.url property to make sure it is set to the correct 
URL to the ERDAS APOLLO catalog.

8. Check the catalog.user and catalog.password properties to make 
sure they are set to a user who has permission to write to the 
ERDAS APOLLO database.

9. Save and close the build.properties file.

10. To run the harvester tool, type ant run at the prompt and press 
Enter.

After the harvesting is complete, the harvester will display the number 
of OGC service providers that were harvested and the number that 
were unable to be harvested. A list of the services that could not be 
harvested is displayed, along with a message to indicate the reason 
that the harvesting failed. 

If you are able to correct any of the situations that caused these 
services to not be harvested, you can try to harvest these services 
again. The tool places the list of the services that failed to harvest in the 
file services-exceptions.txt. You can run the tool to just try to 
harvest these services by typing the following at the prompt and 
pressing Enter:

ant run -Dservices.path=services-exceptions.txt 

Keeping Your Existing Customizations

After you have installed the new version of ERDAS APOLLO Server, 
you will need to make sure the customizations to your ERDAS APOLLO 
system are retained in the newer version of the software. 

Because there are many different combinations of customizations that 
you could have made to your ERDAS APOLLO system, an 
administrator who knows what files were changed will need to open the 
changed files in the previous installation and use them as a guide to 
change the files in the new installation.
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For more information about the possible customizations for the ERDAS 
APOLLO system, see the appropriate ERDAS APOLLO Administrator’s 
Guide for your product level.

It is especially important that you make sure you add any custom 
SRSs back to the system before you begin using it. The chapter 
entitled “Adding a New SRS” in the ERDAS APOLLO Administrator 
Guide: Advantage /Professional Edition contains complete 
instructions on how to add your custom SRSs back to the system.

If you were using geoprocessing (WPS) in the previous version of 
your software, you may need to move the WPS models or change 
the folder where the newest installation of ERDAS APOLLO will 
look for them. By default, ERDAS APOLLO expects to find the 
models in the folder <APOLLO_HOME>\storage\wps. 

For more information, see the section entitled “Specifying the 
Storage Directories for WPS Models and Outputs” in the ERDAS 
APOLLO Administrator Guide: Advantage /Professional Edition.

New ERDAS APOLLO 
Users

If you need to customize your installation, see the ERDAS APOLLO 
Administrator’s Guide - (Advanced/Professional or Essentials-SDI 
edition)

To begin using the system, you will use the ERDAS APOLLO Data 
Manager to either create a catalog and/or create service providers for 
your data (depending on which edition of ERDAS APOLLO that you 
purchased). The ERDAS APOLLO Data Manager Guide provides 
information about the interface in that program as well as instructions 
for using it.

After you have created a catalog and/or service providers, refer to the 
ERDAS APOLLO User Guide for instructions for setting up the web 
client for your end users and for using the web client.
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ERDAS-Net Licensing

Licensing the 
Software

All ERDAS software requires a license to operate. Software licenses 
are based on the ERDAS products and number of seats you 
purchased. The ERDAS-Net Licensing tools set up and manage the 
software licenses needed to run all ERDAS software. You can monitor 
license and module usage and borrow a floating license from the 
license server so you can use the product(s) when your computer is 
disconnected from the server. For certain desktop products, end 
users can borrow a floating license and run ERDAS products while 
disconnected from the server.

ERDAS-Net Licensing is based on FLEXnet Publisher from Acresso 
Software. FLEXnet supports advanced security technologies and 
provides an easy and flexible method to request and use licenses for 
all ERDAS software. FLEXnet works in a similar manner across 
several operating system platforms. 

• You need a new license each time you upgrade to a new release of 
any ERDAS software. A new license supersedes any existing 
license; you do merge or delete any older license files.

• Any older versions of ERDAS software (such as IMAGINE 9.2 or ER 
Mapper 7.1) that used the FLEXlm licensing does not work directly 
with ERDAS-Net Licensing, but both systems can be operated on 
the same machine simultaneously. 

• A dongle is an optional hardware key that provides a unique 
identifier for your computer. Other forms of unique identification are 
available, but a dongle makes it simpler to transfer a license from 
one computer to another. ERDAS-Net Licensing supports SafeNet 
(Windows only) and FlexNet ID dongles.

• You must have a unique system ID for each computer on which you 
install ERDAS software. Access System -> ERDAS-Net Show 
System ID to determine your unique system ID(s). 

• ERDAS-Net Licensing supports both node-locked and floating 
licenses. 

• You can install ERDAS-Net Licensing on a machine that has no 
other ERDAS products in order to operate a stand-alone floating 
license server.

For more information on using FLEXnet License Administration, 
from the Start menu -> All Programs -> ERDAS -> ERDAS-Net 
Licensing -> FLEXnet Administration Guide.

../../../../Shared/licensing/bin/ntx86/licenseadministration.pdf


28 ERDAS-Net Licensing

You must have administrative privileges to set or change the 
licensing settings on a Windows operating system.

Supported 
Platforms

ERDAS-Net Licensing supports the following operating systems. 

• Windows XP (32 and 64-bit)

• Windows Vista Enterprise (32 and 64-bit) 

• Windows 7 (32 and 64-bit) 

• Windows Server 2003 (32 and 64-bit)

• Windows Server 2008 (32 and 64-bit)

• Red Hat Enterprise 5.x (32-bit x86)

• CentOS 5.x (32-bit x86)

• SPARC Solaris 10 (only ERDAS-Net 2009.02 is available on 
SPARC Solaris, and can be used as a license server for all ERDAS 
2010 products.) 

Install ERDAS-Net 
Licensing - 
Windows

This section includes the following instructions. 

• install files to set up and maintain a stand-alone Windows license 
server that serves ERDAS floating licenses

• enable licensing for an application that requires ERDAS-Net

• upgrade from a version of ERDAS-Net Licensing

If you have an existing ERDAS-Net License Server, the installer stops 
and restarts the server during installation. Applications using the 
ERDAS-Net License Server may be disrupted during installation. 

1. Double-click on the ERDAS-Net Licensing installer icon  to launch 
the installer. After the install unpacks and initiates, the Welcome dialog 
opens.

2. Click Next to continue and the ERDAS Software License Agreement 
dialog opens. 
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3. Accept the License terms and click Next and the Ready to Install the 
Program dialog opens. 

4. Click Install. When the install completes, the Install Completed dialog 
opens.

5. Click Finish to complete the installation.

Command Line 
Installation

ERDAS-Net Licensing for Windows can be installed and uninstalled 
from the command line. This is useful for unattended or "Silent" 
installations and uninstallations, removing specific features, generating 
installation logs, and batching multiple product installations. 

In order to install ERDAS software products in unattended mode, you 
must agree to the terms of the End-User License Agreements (EULAs) 
that apply to the ERDAS products, and you must be authorized to bind 
your company or agency to these terms.

You must possess a strong knowledge of Windows command line 
scripting techniques and be familiar with both Windows environment 
variables and the concepts of variables and properties to install from the 
command line.

Use the following information to install/uninstall from the Command 
Line.

Product Code

This install product code is required for command line removal of 
Windows Installer-based setups.

2008.02 - {8140DA5E-0381-4F7D-AD24-F9B5944FD043}

2009.02 - {AEC1AB94-1AC8-44CC-B0EC-F1887F7DE794}

10 - {64F574FE-D3D2-437A-9F4A-B274AA0A503E}

11 - {DCF27946-D8D8-4D25-8F3C-A1BB6C5A6226}

Feature Table

Windows Installer-based setups can be arranged internally by 
"Features." Features selectively install or remove portions of an install 
setup.
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Setting INSTALLDIR

ERDAS-Net Licensing files are used by multiple products and are 
designed to install to the [ProgramFiles]\ERDAS\Shared folder. 
(Where [ProgramFiles] is either "Program Files" or "Program Files 
(x86)" as specified by the operating system.) Do not set the Windows 
Install property, INSTALLDIR, to change the default installation 
location. 

Examples

Silent Install - Install All Features

ERDAS-Net_Licensing.exe /S /V"/qn"

Silent Install - Install Some Features

ERDAS-Net_Licensing.exe /S /V"/qn ADDLOCAL=Licensing,Java"

Silent Uninstall of 2008.08 with Full Logging Enabled

msiexec.exe /x {8140DA5E-0381-4F7D-AD24-F9B5944FD043} /lvx\* "C:\temp 
folder\uninstall2345.txt"

Files and Folders This section includes important files and folders related to ERDAS-Net 
Licensing.   Consider [ProgramFiles] as [Program Files (x86)] on 64-bit 
Windows Installations.

Feature 
ID Description Required

Licensing Files related to ERDAS-Net Licensing Yes

Borrowing A utility for checking out FLEXnet floating 
licenses.

No

SafeNet SafeNet Sentinel dongle driver installer No

FLEXid FLEXnet FLEXId dongle driver installer No

Java A Java runtime.  Required to operate the 
License Administration tools.

No
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erdasnet_LICENSE_PATH 

File created by the License Admin tools to store the license sources 
entered into the Admin tool.

(Windows Vista/2008/7) 
C:\Users\All 
Users\ERDAS\shared\licensing\erdasnet_LICENSE_PATH 

(Windows XP/2003) 
C:\Documents and Settings\All Users\Application 
Data\ERDAS\shared\licensing\erdasnet_LICENSE_PATH

erdasnet.log 

Log file produced by the ERDAS-Net License server executable.

(Windows Vista/2008/7) 
C:\Users\All Users\ERDAS\shared\licensing\erdasnet.log

(Windows XP/2003)
C:\Documents and Settings\All Users\Application Data\ERDAS\shared\licensing\erdasnet.log 

[ProgramFiles]\ERDAS\Shared

The primary installation folder of the License Admin tool and ERDAS-
Net Licensing server. 

[ProgramFiles]\ERDAS\Shared\jre1.6.0_20

The Java Runtime recommended for use with the ERDAS-Net License 
Admin Tools.

[ProgramFiles]\ERDAS\Shared\licensing\config\mappings

File used for translating license file feature codes into standard 
application feature names. 

[ProgramFiles]\ERDAS\Shared\licensing\floating-licenses\erdasnet.opt

Configuration file used to disable license borrowing. For more 
information on enabling license borrowing refer to the online help for the 
License Admin Tools. 

Registry Keys The following registry key is created during setup so ERDAS-Net 
Licensing applications can locate and update configuration files 
required for proper operation.
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HKEY_LOCAL_MACHINE\SOFTWARE\ERDAS\Licenses\INSTALLDIR

Uninstallation Use the MS Add/Remove programs tool from the Control Panel to 
uninstall ERDAS-Net Licensing. 

If an existing ERDAS-Net License Server has been configured and is 
running on the target system, the ERDAS-Net Licensing uninstall 
attempts to remove the ERDAS-Net License Server Windows service.  
Reload your floating license file to recreate the Windows service. 

Some files may remain after uninstallation. Files shared with other 
products such as ERDAS IMAGINE, LPS, and ER MAPPER will not be 
removed until those products are also uninstalled. 

Other licensing files created post installation are not removed. These 
files do not affect usability and include the following.

userhome\erdasnet_licensing

Configuration information generated by the License Admin tool 
generated in the user's home folder.

(Windows Vista/2008/7)
C:\Users\<myuserid>\erdasnet_licensing

(Windows XP/2003)
c:\Documents and Settings\<myuserid>\
erdasnet_licensing

erdasnet_LICENSE_PATH

File created by the License Admin tools to store the license sources 
entered into the Admin tool.

(Windows Vista/2008/7) 
C:\Users\All Users\ERDAS\shared\licensing\erdasnet_LICENSE_PATH 

(Windows XP/2003)
C:\Documents and Settings\All Users\Application 
Data\ERDAS\shared\licensing\erdasnet_LICENSE_PATH

License File Folder

C:\Users\All Users\ERDAS\shared\licensing\licenses

(Windows Vista/2008/7) 
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C:\Documents and Settings\All Users\Application 
Data\ERDAS\shared\licensing\licenses

(Windows XP/2003)

Folder created by the License Admin tools when license files have been 
loaded.  A copy of the original license is stored here and used by the 
tool to serve both floating and node-locked licenses. 

Install ERDAS-Net 
Licensing - 
Unix/Linux 
(supported 
platforms)

Follow these instructions to install files to set up and maintain a stand-
alone license server that serves ERDAS floating licenses.

Root User Required To prevent multiple copies of ERDAS-Net Licensing tools from being 
installed, the license tools must be installed and uninstalled by the root 
user.

If root privileges are carefully controlled on your system, the sudo utility 
is an effective way to emulate the root user in order to install ERDAS-
Net Licensing.  To use sudo to install the tools, add the user account to 
the sudoers table.

Environment Variables ERDAS-Net Licensing for UNIX is designed to be a single component 
shared by all applications on that machine. If you install ERDAS-Net 
Licensing to the default location, you do not need to change the 
ERDASNET_LICENSING_HOME environment variable. 

If you do not install in the default location, define the 
ERDASNET_LICENSING_HOME variable to point to the new location. 

The following example shows the environment variable being set to the 
custom location of /usr/mydir/erdas/licensing.

ERDASNET_LICENSING_HOME =/usr/mydir/erdas/licensing

You must ensure that the variable is defined for any user profile that 
needs to work with the ERDAS-Net Licensing tools or to operate 
applications on Unix/Linux platforms that rely upon ERDAS-Net 
Licensing (via startup, login, service scripts, etc.). 
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Launch Installer The installer name is erdasnet-licensing.bin. Launch it by double-
clicking the installer icon or by entering the installer name in a shell 
window.

./erdasnet_licensing.bin 

Installation Modes The installer has multiple installation/uninstallation modes of operation:  
User Interface (GUI), Console, and Silent mode.

• GUI mode presents installation interactive dialogs and messages.  
This is the default mode for the installer. To use GUI mode, set the 
DISPLAY variable and export it for the user launching the installer. 

• Console mode is a text-based interface for installation that can be 
performed in a console or shell window without DISPLAY variable 
requirements. 

• Silent mode allows for the application to be installed without any 
user interface. Silent installs require a response file 
(installer.properties) file. A default response file is provided with the 
installer. Refer to Silent Installation/ Uninstallation on page 35. 

In order to install ERDAS software products in silent mode, you 
must agree to the terms of the End-User License Agreements 
(EULAs) that apply to the ERDAS products, and you must be 
authorized to bind your company or agency to these terms.

To perform a Console or Silent installation, launch the installer with the 
following options.

Console Mode:  ./erdasnet_licensing.bin -i console 
Silent Mode:      ./erdasnet_licensing.bin -i silent 

Installation These instructions describe the GUI and Console installation modes. 

1. Launch the erdasnet_licensing.bin file and the Welcome dialog opens.

2. Press Next to continue and the ERDAS Software License Agreement 
dialog opens. 

3. Accept the License terms and the Choose Install Folder dialog opens.
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4. ERDAS-Net Licensing for UNIX is designed to be a single component 
that is shared by all applications on that machine. By default, it is 
expected to operate in /usr/local. If you install ERDAS-Net into the 
default location, no additional configuration is required. However, if you 
do not install into the default location, you must define the 
ERDASNET_LICENSING_HOME environment variable, so that all 
applications can find the licensing configuration and shared licensing 
components. This variable is also necessary to operate the ERDAS-Net 
Licensing Administration tools. 

5. The default installation folder for the ERDAS-Net Licensing tools is 
/usr/local.  Click Choose or type in the text field, to select an 
alternate install location.  The install appends "/erdas/licensing" to 
the provided installation folder. The Pre- Installation Summary dialog 
opens.

6. Verify the installation information and click Install when the setup is 
correct. The Installing ERDAS-Net Licensing dialog opens and shows 
the progress of the install.

7. When the Install Complete dialog opens, click Done to close the dialog.

The files and folders in the "licensing" install folder have full read-write-
execute permissions enabled. While licensing tasks should be 
performed by admin level users, this is done to allow any admin user 
the ability to work with ERDAS-Net Licensing files. One important 
aspect of ensuring that users other than root can work with the licensing 
tools, is the creation of the ERDASNET_LICENSING_HOME 
environment variable. See Environment Variables  on page 32.

Uninstallation Use the uninstallation script that is copied by the installer to the 
"licensing" subfolder of the installation.  If the default installation folder 
is accepted during install, the uninstall folder is: 
/usr/local/erdas/licensing/Uninstall_ERDAS-Net_Licensing

You must be logged on as a root user to uninstall ERDAS-Net 
Licensing.

• If logged in as root, and the DISPLAY variable is set and exported, 
launch the uninstall in GUI mode by launching the 
"Uninstall_ERDAS-Net_Licensing" executable in the 
"Uninstall_ERDAS-Net_Licensing" folder. 

• The uninstall can be launched in console or silent mode using the "-
i" installation option. 

1. Launch the uninstaller as listed above and the Root User Required 
dialog opens.



36 ERDAS-Net Licensing

2. If you are not logged on as root user, select Cancel. You do not have 
permissions to uninstall the application.
If you are logged in as root user, click OK and the Uninstall ERDAS-Net 
Licensing dialog opens and shows the progress of the uninstall.

3. When the uninstall is complete, click Done.

Reinstalling/Upgrading When you reinstall/upgrade ERDAS-Net Licensing you must uninstall 
the application and then reinstall your license file.   Be sure to locate 
your license file before you reinstall/upgrade your ERDAS-Net 
Licensing.

Take care when reinstalling or upgrading ERDAS-Net Licensing since 
the license service will stop during the reinstall/upgrade. Stopping the 
license service will stop any active applications and may require some 
start scripts to be adjusted.

The Existing Installation Detected dialog reminds you to uninstall the 
previous version if you try to reinstall/upgrade over an existing 
installation. 

Startup Scripts/Service 
Setup

ERDAS-Net Licensing automatically creates a service on Microsoft 
Windows, which restarts the license server every time the machine 
reboots.

On platforms other than Windows, follow these instructions to make the 
license server start automatically when your UNIX machine boots.

• For the supported Solaris operating systems (available in ERDAS-
Net 2009.02 only), copy the 
/usr/local/erdas/licensing/bin/S99erdasnetlicensing script to the 
/etc/rc3.d folder.  

• For supported Linux operating systems, copy the 
/usr/local/erdas/licensing/bin/S99erdasnetlicensing script to the 
etc/init.d folder.  

• If you choose the default installation folder during setup 
(/usr/local), the scripts work together to start the ERDAS-Net 
Licensing server upon reboot.  

• If you changed the installation folder during setup, you must edit the 
S99erdasnetlicensing and erdasnetlm scripts to reflect the correct 
installation path.

Silent Installation/ 
Uninstallation

Silent installs require a response file which includes answers to 
questions presented during a GUI or Console driven installation.
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• A default response file, named "installer.properties" is included next 
to the erdasnet_licensing.bin file in the ERDAS-Net Licensing 
distribution.  You can remove this file and not affect the ability of the 
install to deliver files. 

• If the user has permissions to update or create files in the folder 
from where it is launched, and no response file exists, the response 
file is generated automatically by the installer when performing an 
install.  If a response file exists in the folder where the installer was 
launched, it will be updated with the answers supplied during setup. 

• By default, the installer searches for the response file in the same 
folder as the installer.  An alternate location for the response file can 
be specified: "./erdasnet_licensing.bin -i silent -f <path 
to properties file>".  You may use a direct or relative path to 
the properties file. 

• When the installer is launched, if the installer.properties file exists 
next to the installer file, or if its location is specified with the -f 
command line option, the contents of the response file will be used 
as default answers and will populate installer questions posed in 
either a GUI or Console mode installation. 

For the ERDAS-Net Licensing installer, the response file includes a 
single property which defines the desired folder location of the install.  
The default install folder is "/usr/local".   You can edit this in the 
installer.properties file prior to installation.

USER_INSTALL_DIR=/usr/local 

Files and Folders This section includes important files and directories related to ERDAS-
Net Licensing. 

/var/.com.zerog.registry.xml

Stores the version and folder location of the latest install. The installer 
checks this file to determine if an ERDAS-Net Licensing install exists. 
The install attempts to direct itself to the previous install's version and 
folder location stored in this file. 

The .com.zerog.registry.xml file is written to the /var folder when 
installed by the root user.  
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If installs and uninstalls are not performed by the root user, the 
information in the file can become out of sync with the environment, 
which may cause incomplete installations.  You can delete the file and 
reinstall ERDAS-Net Licensing to restore the installation, but be aware 
that all InstallAnywhere installations use the registry file. If you delete 
the file you could adversely effect the installation behavior of other 
installs. 

/usr/local/erdas/jre1.6.0_20/

The Java Runtime recommended for use with the ERDAS-Net License 
Admin Tools.

/usr/local/erdas/licensing/bin 

Scripts for starting the license service on reboot for nonWindows 
platforms. See Startup Scripts/Service Setup  on page 35. 

/usr/local/erdas/licensing/erdasnet_LICENSE_PATH

File created by the License Admin tools to store the license sources 
entered in the Admin tool. This file verifies to a new install that a current 
install is present.

/usr/local/erdas/licensing/licenses/ 

Folder created by the License Admin tools when license files have been 
loaded.  A copy of the original license is stored here and used by the 
tool to serve licenses - both floating and node-locked licenses.

/usr/local/erdas/licensing/config/mappings

File used for translating license file feature codes into standard 
application feature names.

/usr/local/erdas/licensing/licenses/floating-licenses/erdasnet.opt 

Configuration file deployed with the application to disable license 
borrowing. For more information on enabling license borrowing please 
see the online help included with the License Admin tools. 

Remaining Files Some files created post installation may remain after uninstallation. 
These files do not affect usability and include the following.

/userhome/erdasnet_licensing 

The License Admin tool generates configuration information in the 
user's home folder. 
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/usr/local/erdas/licensing/erdasnet_LICENSE_PATH 

File created by the License Admin tools to store the license sources 
entered in the Admin tool. 

/usr/local/erdas/licensing/licenses/ 

Folder created by the License Admin tools when license files have been 
loaded.  A copy of the original license is stored here and used by the 
tool to serve floating and node-locked licenses. 

Additional Information

Libgtk

On Red Hat Linux the license admin tools require GTK libraries that 
may not exist on the system.  It may be necessary to locate and install 
libgtk-x11-2.0.so.0 to operate the admin tools on RedHat Linux 
platforms.

iiimx IM Status Windows on Solaris

On versions of Solaris systems, when installing or running the License 
Admin Tools, one or more small windows may appear under the lower-
left corner of the main active window.  The small windows have the title 
"iiimx IM Status" and contain a line like "[Francais/European]" or 
"[English/European]".   When clicking in the small window, a new one 
appears with title "Cygwin/X X" and contains a list of languages.  You 
cannot remove the window without killing the main one.

Follow these steps to correct the problem.

1. $ gconftool-2 -s /desktop/gnome/interface/gtk-im-status-
style -t string none 

2. $ gconftool-2 -s /desktop/gnome/interface/gtk-im-preedit-
style -t string none 

3. $ gnome-accessibility-keyboard-properties 

4. Switch the accessibility enhancements on 

$ iiim-properties 

5. Set the iiim window to "none" in the GUI (by unchecking the "Activate 
the input method" box).
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Security-Enhanced SELinux

You cannot run ERDAS-Net or any licensed ERDAS application if 
default Security-Enhanced Linux (SELinux) policies are in effect. 
Licensing includes certain third-party binary code which is not 
compatible with the stringent requirements of SELinux. Either disable 
SELinux (see the following section) or relax the policies to allow 
ERDAS-Net utilities and the licensed ERDAS Applications to run 
without meeting the requirements for position-independent code.

Disable SELinux

If the error message “./libjvm.so: cannot restore segment prot after 
reloc: Permission denied” displays, do the following. 

1. $ su root 

2. # system-config-securitylevel 

3. In the window that appears, select the SELinux tab 

4. Disable SELinux

Acquire and 
Enable a Software 
License

1. Install the ERDAS software from DVD. To use ERDAS-Net Licensing 
on a machine that does not have other ERDAS products installed, 
install only ERDAS-Net Licensing from the Install DVD. 

2. Determine your unique System ID. From the Start menu -> All 
Programs -> ERDAS -> ERDAS-Net Licensing -> Show ERDAS-Net 
System ID. Copy the ID to use it in the next step.

3. Request a License file from ERDAS using your unique System ID. From 
the Show ERDAS-Net System ID dialog, click Request License to 
access the ERDAS Product Licensing webpage and submit your unique 
system ID. ERDAS will e-mail you a zipped file containing the license 
file. 

If you purchased your ERDAS software from a distributor, contact 
your distributor to request your license file. 

4. Unzip the License file. Note the location of the unzipped license file.
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5. Load the license file from ERDAS-Net License Administration dialog 
select File -> Load License File. Now you can manage your licenses 
from the ERDAS-Net License Administration dialog. See the online help 
for details.

Floating Licenses 
and Firewalls

You may find that a floating license only works for the software on the 
license server machine itself.  By default, Microsoft Windows (and 
several commercial vendors) provide firewall software which protects 
your computer system by blocking out requests that come from other 
machines.  Often these firewalls cause legitimate requests for floating 
software licenses to fail.

Disabling your firewall completely is a good way to confirm if a firewall 
is preventing other machines from sharing floating licenses.  If the 
firewall is blocking ERDAS-Net licensing requests, the following 
instructions describe how you can permit ERDAS-Net license requests, 
without leaving your license server vulnerable.

The ERDAS license server consists of two components; the license 
broker (lmgrd) and the vendor daemon. The client workstation sends a 
license request to the license broker, which queries the vendor daemon 
whether or not there is a valid license. The vendor daemon checks the 
license validity based on its own algorithm, and then sends the return 
back to the license broker, which lets license broker communicate with 
the client.

By default, the license broker uses TCP port 27000. If port 27000 is 
used by another program, the license broker will use another port 
available from range 27001-27009. Usually TCP port 27000 is open on 
most firewalls, but ports 27001-27009 are often blocked.

The vendor daemon also uses one (generally) unpredictable TCP port 
(e.g., port 1205) to communicate with the license broker, so that both 
the license broker and the vendor daemon have a distinct TCP port. The 
TCP port used by the vendor daemon can change every time the 
license server is restarted, and some firewalls block the ports which the 
vendor daemon uses.

In order to unblock the communication between the client, license 
broker, and vendor daemon, add the license broker, the vendor 
daemon, and their TCP ports to the Windows firewall exceptions list.

The general steps to open a firewall are as follows.

1. Select appropriate ports for use by the license broker and vendor 
daemon. 

2. Configure the ERDAS license file to always use your selected ports. 
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3. Set up the firewall: add the license broker and the vendor daemon and 
their ports to the firewall exceptions list. 

Refer to the following sections for the specific process for the ERDAS-
Net and the FLEXlm license system. Each system includes instructions 
for Windows XP and the Vista version. 

ERDAS version 9.3 and higher (released 10/6/2008) use the FLEXnet-
based ERDAS-Net license manager. The FLEXlm instructions are for 
ERDAS versions 9.2. and earlier which use the FLEXlm-based license 
manager. 

Select the TCP Port Select the appropriate TCP port for use by the license broker and 
vendor daemon.

• The license broker uses TCP port 27000 by default. This is the best 
choice for any system which uses a single license server.

• The vendor daemon picks the first available port, but the choice may 
be different every time the license server is restarted.

• One way to find a TCP port available for use is to start the license 
manager process and examine the license server log file:

For Windows XP: 
C:\Documents and Settings\All Users\Application 
Data\ERDAS\Shared\licensing\erdasnet.log

For Windows Vista Enterprise: 
C:\Users\All Users\ERDAS\Shared\licensing\ 
erdasnet.log

This log file shows which ports were assigned at startup. For 
instance, in the following example log, you can see that the license 
broker TCP port is 27001, and the vendor daemon TCP port is 
1205. (The number 2688 is a process identifier, and is not relevant 
to this procedure.)

16:43:24 (lmgrd) License file(s): C:\Program 
Files\ERDAS\Shared\licensing\licenses\floating-
licenses\LocalServerLicense.elf

16:43:24 (lmgrd) lmgrd tcp-port 27001

16:43:24 (lmgrd) Starting vendor daemons ... 

16:43:24 (lmgrd) Started erdasnet (pid 2688)...
11:12:16 (lmgrd) erdasnet using TCP-port 1205

Configure the ERDAS 
License File

Follow these instructions to configure the ERDAS license file to always 
use your selected ports
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You can control the port number used by the ERDAS-Net license server 
by editing the first two lines of the floating license file at:

[ProgramFiles]\ERDAS\Shared\licensing\licenses\floatin
g-license\LocalServerLicense.elf. 

You may only modify the first two lines of the file. Do not edit the main 
encrypted body (from the word INCREMENT onward) of the license file 
or you will invalidate the license. For example:

SERVER this_host erdasnet=3ad21234 27001 

VENDOR erdasnet port=1205 

USE_SERVER 

INCREMENT…>

Adding 27001 after the “this_host erdasnet=3ad21234” on the 
SERVER line ensures that the license broker always uses port 27001. 
This can be helpful when you are running multiple license servers on 
the same machine, by ensuring that each software vendor’s license 
broker gets the same port every time the machine starts up.

Adding port=1205 on the VENDOR line ensures that the vendor 
daemon always uses port 1205.

Open the Windows XP Firewall 

Follow these instructions to set up the Windows XP firewall by adding 
the license broker, vendor daemon, and their TCP/IP ports to the 
exception list.

1. Select Start -> Control Panel -> Security Center -> Windows 
Firewall. 

2. Make sure the Don’t allow exceptions check box is unchecked. 

3. Select Exceptions -> Add Program..." and the Add a Program dialog 
opens. 

4. Select Browse and a file chooser dialog opens. 

5. Browse to [ProgramFiles]\ERDAS\Shared\licensing\bin\ntx86, 
highlight lmgrd.exe, then click Open. The Add a Program dialog opens 
with the “ERDAS” entry selected by default. 

6. Click OK. 

7. Select the Add Program... button again and the Add a Program dialog 
opens.
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8. Click Browse and a file chooser opens. 

9. Browse to [ProgramFiles]\ERDAS\Shared\licensing\bin\ntx86, 
highlight erdasnet.exe, and click Open. The Add a Program dialog 
opens with the “ERDAS” entry selected by default. 

10. Click OK. 

11. Click Add Port... and the Add a Port dialog opens.

12. Enter “lmgrd tcp port” as the name and enter the port number for the 
lmgrd license broker (e.g., 27001). 

13. Click OK to close the Add a Port dialog. 

14. Click Add Port... again. Enter “erdas tcp port” as the name and enter 
the port number for the vendor daemon (e.g., 1205). 

15. Click OK to close the Add a Port dialog. 

16. Click OK to close the Windows Firewall dialog. This makes the license 
server visible to all clients. 

Open the Windows Vista Firewall

Follow these instructions to set up the Windows Vista firewall by adding 
the license broker, vendor daemon, and their TCP/IP ports to the 
exception list.

1. From the Windows Control Panel -> Security -> Windows Firewall -> 
Allow a program through windows firewall. A new dialog named 
“windows firewall settings” opens. 

2. Select Exceptions -> Add Program... and the Add a Program dialog 
opens. 

3. Select Browse and a file chooser opens. 

4. Browse to [ProgramFiles]\ERDAS\Shared\licensing\bin\ntx86, 
highlight lmgrd.exe, then click Open. The Add a Program dialog opens 
with the ERDAS entry selected by default. 

5. Click OK. 

6. Select Exceptions -> Add Program... and the Add a Program dialog 
opens. 

7. Click Browse and a file chooser opens.

8. Browse to [ProgramFiles]\ERDAS\Shared\licensing\bin\ntx86, 
highlight erdasnet.exe, then click Open. The Add a Program dialog, 
opens with the “ERDAS” entry selected by default. 
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9. Click OK. 

10. Click Add Port... and the Add a Port dialog opens. 

11. Enter “lmgrd tcp port” as the name and enter the port number for the 
lmgrd license broker (e.g., 27001). 

12. Click OK to close the Add a Port dialog. 

13. Click Add Port... again. Enter “erdas tcp port” as the name and enter 
the port number for the vendor daemon (e.g., 1205). 

14. Click OK to close the Add a Port dialog. 

15. In the Windows Firewall dialog, click OK to close the Windows Firewall 
dialog. This makes the license server visible to all clients.

Open the Windows 7 Firewall

Follow these instructions to set up the Windows 7 firewall by adding the 
license broker, vendor daemon, and their TCP/IP ports to the exception 
list.

1. From the Windows Control Panel -> System & Security -> Windows 
Firewall -> Allow a program through Windows firewall. A new dialog 
named “windows firewall settings” opens. 

2. Click Settings.

3. Click Allow another program and the Add a Program dialog opens. 

4. Select Browse and a file chooser opens. 

5. Browse to [ProgramFiles]\ERDAS\Shared\licensing\bin\ntx86, 
highlight lmgrd.exe, then click Open. The Add a Program dialog opens 
with the ERDAS entry highlighted. 

6. Click Add. 

7. Select Exceptions -> Add Program... and the Add a Program dialog 
opens. 

8. Click Browse and a file chooser opens.

9. Browse to [ProgramFiles]\ERDAS\Shared\licensing\bin\ntx86, 
highlight erdasnet.exe, then click Open. The Add a Program dialog, 
opens with the “ERDAS” entry highlighted. 

10. Click Add.
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11. From the Control Panel select System & Security -> Windows 
Firewall -> Advanced Settings -> Windows Firewall with Advanced 
Security -> Inbound Rule -> New Rule and the New Inbound Rule 
Wizard dialog opens.

12. Select Protocol & Ports and click the TCP and Specific Local Port 
radio buttons.

13. Enter 27002 in the Specific Local Port field.

14. Click Next -> Allow the Connection -> Next and the Profile dialog 
opens.

15. Select the profile(s) that best fits your deployment and click Next.

16. Enter Imgrdtcp port as the Name and click Finish.

17. Repeat for Outbound Rule.

18. Repeat inbound and outbound for the other port. 

Using Floating Licenses 
over a VPN or WAN

If you have difficulty connecting to an ERDAS-Net Licensing Server on 
a slow or wide-area network specify a fixed port number and/or adjust 
the time-out value to improve the connection reliability.

Specify a Fixed Port Number

Using a fixed port number for a license server speeds up all requests 
made to the license server, since FLEXnet does not have to scan the 
default port range of 27000 to 27009. Follow the instructions in the 
previous section, Configure the ERDAS License File on page 41 to 
specify a fixed port number for the ERDAS-Net license broker; 
otherwise the number can vary depending on what other license 
servers are running on your machine. 

Even when the port is in the default range, the connection will be faster 
is you set the specific port number rather than just increasing the 
FLEXLM_TIMEOUT (see below). 



ERDAS-Net Licensing 47

Increase the Time-out Value

If you cannot specify a port number, you can increase the 
FLEXLM_TIMEOUT to give each possible port a chance to respond. On 
Microsoft Windows clients, adjust the FLEXLM_TIMEOUT variable if 
you have difficulty connecting to a slow or wide-area network. The 
default time-out value is 100,000 (measured in microseconds, this is 
equivalent to one tenth of a second). Adjusting this value to 200,000 or 
300,000 improves the likelihood of connecting to a distant license 
server, but it also increases the time required for the software to fail 
when the license server is not available, particularly if you have not 
specified a fixed port number. 

When specifying the FLEXLM_TIMEOUT, include the number of 
microseconds without any quotes or commas.  A value of "500000" 
corresponds to a half second, which might only be necessary for an 
extremely slow network.
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Cluster Computing
ERDAS APOLLO provides high performance with a large number of 
users. You can increase the performance using cluster computing. The 
servers in this cluster share the incoming requests from the Data 
Manager and the Web Client users so that your system can handle a 
higher user volume and even larger requests. 

A computer cluster consists of linked computers, each serving a 
specific function and sharing the computational load of processing to 
improve performance and availability over using a single computer. 
Cluster computing is highly configurable and depends on your available 
hardware. This section gives one example of a cluster setup; describing 
all possible configurations is outside the scope of this document. 

Refer to the following diagram for a description for the example 
computer cluster.

The workhorses of the cluster are the servers, each installed with the 
Server application. All servers are connected to the same database. 
You can have an unimited number of Servers (nodes) in a cluster.

The cluster of Servers interact with the Web Client end users through a 
load balancer . When an end user begins a session with the Web Client, 
the load balancer receives the initial request and assigns it to one of the 
computers (nodes) in the cluster. The load balancer assigns all of the 
requests the end user makes during that session to that same server, 
as long as that server is running.  If that server fails, the end user is 
asked to reauthenticate and the load balancer reassigns the requests 
to another server.
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Setup Before you install the application server on the servers, designate each 
computer for a specific function and map all computers to each other. 
Make the database shared by all the server computers. Decide how 
many nodes will be in a cluster and which node will server as Load 
Balancer. 

Servers Designate any number of computers as servers and install the ERDAS 
APOLLO server installation on each. The server installation includes 
the cluster setup and the Web Client and you must know the name and 
IP address of the load balancer and the server when you install the 
application server.

Refer to Server Installation - Windows on page 6 for instructions 
on installing the application server.
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Startup After you install the cluster with the server installation, complete two 
startup tasks.

• Run the batch file lbsetup on the Load Balancer node to create the 
workers file and to configure the node as the load balancer in the 
cluster. From <APOLLO_HOME>\tools\loadbalancer type 
lbsetup.bat.

• Use MS Windows to start the Apache service on each node. 

Configuration

Change Multicast 
Address

After you install the cluster you can change the multicast address 
manually. Make these changes on every node in the cluster.

1. Navigate to 
<APOLLO_HOME>/jboss/server/cluster/deploy/erdas-
apollo.ear/erdas-apollo.war/WEB-INF/classes.

2. Open ehcache.xml.

3. Change the address in the string: multicastGroupAddress.

4. Save the file.

5. Navigate to <APOLLO_HOME>/jboss/server/cluster/deploy.

6. Open cluster-service.xml.

7. Change the address in the string: ${jboss.partition.udpGroup.

8. Save the file.

9. Restart the nodes.

Centralized Logging In a clustered installation, an additional appender is defined in each of 
the cluster nodes to ensure a unified and centralized logging for the 
whole cluster. This is done using the SyslogAppender, a network 
appender that sends logging information to any syslog deamon on the 
network. 

Using that appender, all JBoss nodes send their log message to a 
Syslog daemon (which must be started and listening on the network). 
That Syslog daemon is able to display in real-time messages coming 
from every node, and can redirect that centralized log to a single log file. 
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To be fully functional, the Syslog appender has to be configured within 
the ERDAS APOLLO logging configuration file. This step is done during 
the Cluster section of the installation process, when you are asked for 
the following information.

• Syslog Daemon Host 

• Syslog Daemon Port

The Syslog daemon itself, which will receive all messages sent by the 
log4j Syslog Appender, is not installed/configured during the Installation 
process. Syslog daemons are available on almost all servers (there is 
'syslogd' on Linux, and there are several free or commercial 
implementations of Windows syslog daemon as well).

For more information on Logging, see the ERDAS APOLLO 
Admininstrator’s Guide - Essentials-SDI Edition..
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ORACLE Considerations
The ORACLE 10g database is one database option to store the ERDAS 
APOLLO catalog. ORACLE installation and setup requires an ORACLE 
expert. This section outlines specific ERDAS APOLLO information 
needed for the setup and installation.

• ERDAS APOLLO supports ORACLE 10g2 and 11g

Before Installation Consider these points before you install ORACLE.

• Determine your needs for the quantity and scope of your catalog for 
a least one year.

Instance Creation During Instance Creation remember these points.

• Take care to record the passwords when creating ORACLE internal 
accounts. This information is not available in the DB Summary.

• If you are installing on a laptop (with one physical disk) you will not 
improve performance by selecting the D drive as your Database File 
Location.

• If your system has large, redundant storage choose to Use a 
Common Location for all Database Files.

• If you are using a computer cluster database use Oracle-managed 
files. 

• If you have a a small-medium catalog, run the database at a 
minimum or 256 MB total memory. 

• Set the Block Size to 8192 bytes.

• For a single-user system, set the PROCESSES to 300. 
OPEN_CURSORS to 550, and SESSIONS to 330. For a 50-user 
system, set the PROCESSES to 1,500. OPEN_CURSORS to 
3,000, and SESSIONS to 1655. For larger systems, increase the 
values appropriately.

• Shared server mode must have a multiple-CPU server.

Listener Creation When you create the Listener, consider the following.

• ERDAS APOLLO uses TCP connections to the Oracle database.
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• Do not enable Auto Extend; make temporary table spaces a fixed 
size.

• Create an Oracle user to be the Owner of the Catalog database 
objects.
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 WebLogic
To use the WebLogic application server for your ERDAS APOLLO 
Server installation, install ERDAS APOLLO Server first, but do not 
deploy it. Then, install, configure, and deploy WebLogic. Finally, deploy 
ERDAS APOLLO Server on the WebLogic application server.

Installation Follow the directions from WebLogic to install the software. Use these 
notes for customizing the install for ERDAS APOLLO.

• If you are using the latest edition (11g/10.3.3.0) choose the default 
installation directory of C:\ORACLE\Middleware. 

• Select Custom when the installer asks for the type of installation.

• Select the component WebLogic Server (everything except Server 
Examples).

• Accept the default directories for product installation. 

• Do not install the Node Manager as a Windows Service.

• Accept the default option, "All Users" Start Menu folder for the 
selected WebLogic shortcuts.

Configuration - 
Advantage & 
Professional

The procedure to configure WebLogic application Server to work with 
ERDAS APOLLO Server (Advantage/Professional) has these basic 
parts:

• Create the Domain

• Create the JDBC Data Sources

• Configure the Java Message Service (JMS)

• Configure WebLogic Security

Create the Domain 1. Click the Windows Start button.

2. Click All Programs. 

3. Select ORACLE > WEBLOGIC > WEBLOGIC SERVER 11gR1> 
Tools > Configuration Wizard.
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4. When the configuration wizard opens, it will ask whether you want 
to create a new domain or extend an existing one.  The default 
option is Create a new WebLogic Domain.  Leave this option 
selected and click Next.

5. The wizard asks you to select the domain source. The default option 
is Generate a domain configured automatically to support the 
following products and the WebLogic Server is the only product 
selected. Accept the default selections and click Next.

6. Type apollo_domain in the Domain name box. Do not change the 
path in the Domain location box. Click Next when you are finished.

7. The wizard asks you to create a user who will be the domain 
administrator. Accept the default user name of weblogic and set the 
password to be weblogic1. 
Click Next to continue.

8. The next panel asks you to specify the server start mode and JDK 
to be used for the domain. 

• In the WebLogic Domain Startup Mode section, select 
Development Mode only if you are a developer.  All other types 
of users, including customers, should select Production Mode. 

• In the JDK Selection section, select the Other JDK option. Click 
the Browse button and navigate to the directory where you 
installed the Java JDK. If you accepted the default installation 
location when you installed it, it will be located in 
<APOLLO_HOME>\tools\jdk\jdk1.6.

NOTE: WebLogic will not recognize a JDK path with parentheses.

9. The next panel asks you if you want to select an optional 
configuration. If you need to change the WebLogic port number in 
order to avoid a port conflict on your machine, select Administration 
Server - Modify Settings. click Next.

Type your new port number in the Listen Port box. Your network 
administrator can help you find a new number that is not being 
used already. After you type in your new port number, click Next.

NOTE:  The WebLogic port number can also be changed after the 
installation process.

If you want to change the WebLogic port number after 
installation:
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• Open the file directory 
C:\ORACLE\Middleware\user_projects\domains\apollo_do
main\config\config.xml. 

• If you used the default port number at install time, you will be 
able to find a block of text in your file that looks similar to the 
following (the line in blue will only be there if you tried to set 
the port number to something other than the default value of 
7001 when you first installed WebLogic):

• To change the port number, add the line with the listen-port 
tags if it is not there already and type the port number you 
want to use between the tags.

10. The Configuration Summary page opens. Click Create.

11. The configuration wizard notifies you when the domain has been 
created successfully. Click Done to close the wizard.

Start Admin Server for the WebLogic Server Domain

1. Click the Windows Start button.

2. Click All Programs.

3. Select ORACLE WebLogic > User Projects > apollo_domain >
Start Admin Server for WebLogic Server Domain.

4. A command line window will open. If you are installing in Production 
mode, enter the user name weblogic and the password weblogic1 
to log in to the domain.

5. You will know the server has started successfully when the text 
stops scrolling in the window and you see the notice “Server started 
in RUNNING mode”. 

Do not close the command line window that opened while you were 
starting WebLogic.

Install PostgreSQL 
Drivers

If you are using a PostgreSQL database, install the PostgreSQL 
database drivers before you create the JDBC Data Sources.

<server>
<name>AdminServer</name>
<listen-port>1234</listen-port>
<listen-address></listen-address>

</server>
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1. Find the commEnv.cmd file inside the folder 
<WEBLOGIC_HOME>/wlserver_10.3/common/bin.

2. Right-click on the file and select the Edit option in the menu that 
appears.

3. Find the following line of the commEnv.cmd file:

4. and add the following before this line. Be sure to change 
<APOLLO_HOME> to the directory where you installed ERDAS 
APOLLO Server.

5. Save and close the commEnv.cmd file.

Create the JDBC Data 
Sources

1. Restart WebLogic.

2. Launch the WebLogic Server Administration Console by 
opening your browser and typing 
http://localhost:7001/console in the address bar.

3. Enter the user name weblogic and the password weblogic1 to log 
in to the WebLogic server.

4. Locate the Services node in the Domain Structure box on the left of 
the page and expand it by clicking the plus sign next to it.

5. Find the JDBC node inside the Services node, and expand it by 
clicking the plus sign next to it.

6. Click Data Sources under the JDBC node.

7. Click New.

8. Type WL_MQDS in the Name box.

9. Type WL_MQDS in the JNDI Name box.

10. Select the type of database you will be using for ERDAS APOLLO 
Server in the Database Type list.

11. Click Next.

if NOT “%PATCH_CLASSPATH%”==””

set PATCH_CLASSPATH=<APOLLO_HOME>dist\weblogic\erdas-apollo.ear\erdas-
apollo.war\WEB-INF\lib\postgresql-8.3-603.jdbc3.jar
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12. Select the database driver to be used in the Database Driver list. 

If you are using an Oracle database, select 
*Oracle's Driver (Thin XA) Versions:9.0.1,9.2.0,10

If you are using PostgreSQL, select 
PostgreSQL's Driver (Type 4) Versions:Any

If you are using a Microsoft SQL Server database, select
Microsoft’s MS SQL Server Driver (Type 4 XA) Versions 2000, 
2005

NOTE: If you need to select the PostgreSQL database driver and do not 
see it in the list, you will need to install the PostgreSQL database 
driver.

13. Click Next.

14. Read the Transaction Options statement, accept the defaults, and 
click Next.

15. Type the name of the database you are using for ERDAS APOLLO 
Server in the Database Name box.

16. Type the name or the IP address of the server where the database 
is located in the Host Name box.

17. Do not change the port number in the Port box.

18. Type the name of the database user to log in to the database in the 
Database User Name box.

19. Type the password for that user in the Password box, and again in 
the Confirm Password box.

20. Click Next.

21. Click the Test Configuration button on the top left corner or the 
page to make sure you can connect using the information you 
typed.  Click Next after you know you can connect with this 
information.

NOTE: If you cannot connect, click the Back button and make sure you 
typed the information correctly.  If you typed your information correctly 
and still cannot connect, speak with your database administrator to 
make sure you have the correct database type, database name, server 
name, user name, and password.

22. Check the AdminServer option on the Select Targets page and 
click Finish.
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Configure the Java 
Message Service (JMS)

There are four steps in the process of configuring the Java Message 
Service:

• Create Persistent Stores.

• Configure a JMS Server

• Configure a JMS System Module

• Configure the Resources for the System Module

Create Persistent Stores

1. Find the configuration file that contains all of the settings for this 
domain.
It is named config.xml and is located in the directory 
C:\ORACLE\Middleware\user_projects\domains\apollo_doma
in\config

2. Copy the file and paste it in the same directory so you have a 
backup copy of the working config.xml file.

3. Highlight the original file and right-click it.

4. Select Open With… in the menu.

5. In the Programs list in the Open With dialog, select NotePad. 

6. Click OK.

7. Select the following block of text that is appropriate for your 
database platform and copy it. Remember that <APOLLO_HOME> 
represents the complete path of your installed APOLLO product.

Oracle

<jdbc-store>
<name>APOLLO-JDBCStore</name> 
<data-source>WL_MQDS</data-source> 
<target>AdminServer</target> 
<deletes-per-batch-maximum>20</deletes-per-batch-maximum> 
<inserts-per-batch-maximum>20</inserts-per-batch-maximum> 
<deletes-per-statement-maximum>20</deletes-per-statement-maximum>

</jdbc-store>
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PostgreSQL

Microsoft SQL Server

8. Place your cursor at the beginning of the line that contains the 
following text:

Press Enter to move this line down one line.

9. Place your cursor in the blank line before the line

and paste the copied text into this location in the config.xml file.

10. Save the file and close it.

11. You must stop the WebLogic Admin Server and then restart it so 
that WebLogic will recognize the change to the file. 

Stop WebLogic:

1. Click the Windows Start button.

2. Click All Programs.

3. Select ORACLE > WebLogic > User Projects > 
apollo_domain > Stop Admin Server.

<jdbc-store>
<name>APOLLO-JDBCStore</name>
<create-table-ddl-file>

<APOLLO_HOME>\dist\weblogic\erdas-apollo.ear\erdas-apollo.war\WEB- 
INF\weblogic-postgres.ddl

</create-table-ddl-file>
<data-source>WL_MQDS</data-source>
<target>AdminServer</target>

</jdbc-store>

<jdbc-store>
<name>APOLLO-JDBCStore</name> 
<data-source>WL_MQDS</data-source> 
<target>AdminServer</target> 

</jdbc-store>

<admin-server-name>AdminServer</admin-server-name>

<admin-server-name>AdminServer</admin-server-name>
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4. A command line window will open. If this is Production mode, 
enter the user name weblogic and the password weblogic1 to 
log in to the domain.

Restart WebLogic:

1. Click the Windows Start button.

2. Click All Programs.

3. Select ORACLE > WebLogic > User Projects > 
apollo_domain > Start Admin Server for WebLogic Server 
Domain.

4. A command line window will open. If this is Production mode, 
enter the user name weblogic and the password weblogic1 to 
log in to the domain.

5. You will know the server has started successfully when the text 
stops scrolling in the window and you see the notice “Server 
started in RUNNING mode”. 

Do not close the command line window that opened while you were 
starting WebLogic.

Configure a JMS Server

1. Locate the Messaging node under the Services node and expand 
it by clicking the plus sign next to it.

2. Click JMS Servers under the Messaging node.

3. Click New.

4. Type APOLLO-JMSServer in the Name box.

5. Select APOLLO-JDBCStore in the Persistent Store list and click 
Next.

6. Select AdminServer in the Target list. It will be the target on which 
you will deploy the JMS Server.

7. Click Finish.

Configure a JMS System Module

1. Click JMS Modules under the Messaging node.

2. Click New.



WebLogic 62

3. Type APOLLO-SystemModule in the Name box.

4. Leave the Descriptor File Name and Location in Domain boxes 
blank and click Next.

5. Select AdminServer as the target on which you want to deploy this 
JMS system module and click Next.

6. Check the box next to the question "Would you like to add resources 
to this JMS module?"

7. Click Finish.

Configure the Resources for the System Module

1. Click New.

2. Select Topic as the type of resource you want to create and click 
Next.

3. Type ApolloEventTopic in the Name box.

4. Type topic/ApolloEventTopic in the JNDI Name box.

5. Do not change the selection in the Template list. Click Next.

6. Click the Create a New Subdeployment button located to the right 
of the Subdeployment box.

7. Type ApolloEventTopicSubdeployment in the Subdeployment 
Name box and click OK.

8. ApolloEventTopicSubdeployment should now be selected in the 
Subdeployments list box.

9. Select APOLLO-JMSServer in the Targets list and click Finish. 

10. Click the New button on the Summary of Resources tab.

11. Select Connection Factory as the type of resource you want to 
create and click Next.

12. Type APOLLO-TopicConnectionFactory in the Name box.

13. Type TopicConnectionFactory in the JNDI Name box and click 
Next.

14. Leave the Admin Server checked (default).

15. Click the Advanced Targeting button.
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16. Select ApolloEventTopicSubdeployment in the 
Subdeployments list.

17. The Targets list will appear and APOLLO-JMSServer will be 
selected for you. Accept this selection and click Finish.

Create one more connection factory, using the name 
ConnectionFactory for the Name and the JNDI Name fields.

Configure WebLogic 
Security

When you install ERDAS APOLLO and use the bundled JBoss 
application server, the roles and default users (with predefined user 
names and passwords) are already set up in the system by the installer, 
and you have the option of changing the default user names and 
passwords later. Most customers do change the user names and 
passwords of the default admin and public users, because it makes 
their installations much more secure.

If you are using the WebLogic application server, you will need to create 
roles and users when you set up WebLogic. Set up the users with the 
user names and passwords that you want to use rather than the default 
ones. To make this process a little easier, read about how ERDAS 
APOLLO security works in the “Security” section in the ERDAS 
APOLLO Administrator’s Guide: Advantage/Professional Edition. 

Open the Security Settings

1. In the WebLogic Server Administration Console, find Security 
Realms in the Domain Structure pane on the left of the page and 
click it.

2. In the grid on the middle of the page, click myrealm.

Create New Groups

1. Click the Users and Groups tab.

2. Click the Groups tab.

3. Click the New button.

4. Type esp_administrator in the Name box.

5. Type esp_administrator in the Description box.

6. Leave the option DefaultAuthenticator selected in the Provider 
box. 

7. Click OK.

Create four more groups by following steps 3-7 again, and typing the 
following names and descriptions in steps 4 and 5. 
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• esp_data_manager 

• esp_data_analyst

• esp_consumer

• esp_anonymous

Create New Users

The default users for the ERDAS APOLLO system are shown in the 
following table. 

The instructions for this section will use these default user names and 
passwords; however, you should substitute your own user names and 
passwords for the admin and public users in order to make your 
installation more secure.

If you use a different user name or password for the admin or public 
accounts, then you need to open the global-server.properties file 
and change some things in there as well. You can change the global-
server.properties file either before or after you set the user 
accounts up in WebLogic.

To create the users:

1. Click the Users tab.

2. Click the New button.

3. Type admin in the Name box.

4. Type admin in the Description box.

5. Leave the option DefaultAuthenticator selected in the Provider 
box. 

Table 1: Default User Names and Passwords in ERDAS APOLLO

User Name Password

admin apollo123

dm apollo123

da apollo123

consumer apollo123

public public123
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6. Type apollo123 in the Password box, and again in the Confirm 
Password box. You must use apollo123 as the password for this 
user.

7. Click OK.

Create three more users by following 2-7 again, and typing the following 
as the names and descriptions in 3 and 4. Your passwords must be at 
least 8 characters.

• dm

• da

• consumer

Create one more users by following 2-7 again, and typing public for 
the name and description in steps 3 and 4, and typing public123 as the 
password for this user.

To edit the security settings in the global-server.properties file:

1. Navigate to the global-server.properties file and open it.

If you are using a WebLogic application server, you will be able to 
find it in the following location:

<APOLLO_HOME>\config\erdas-apollo

2. If you changed the admin user name or password, find the 
properties shown in the figure below. 
Change the values of those properties so that they match with the 
Admin user you created.
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3. If you changed the public user name or password, find the 
properties shown in the figure below.
Change the values of those properties so that they match with the 
public user you created.

4. Save and close the global-server.properties file.

Specify Group Membership for Users

1. Click admin in the Users table.

2. Click the Groups tab.

3. Find esp_administrator in the Available list in the Parent Groups 
section and highlight it.

4. Click the right-pointing arrow to move esp_administrator from the 
Available Parent Groups list to the Chosen Parent Groups list.

5. Find esp_consumer in the Available list in the Parent Groups 
section and highlight it.

6. Click the right-pointing arrow to move esp_consumer from the 
Available Parent Groups list to the Chosen Parent Groups list.

7. Click Save.

8. At the top of the page, there is a breadcrumb trail that tells you what 
you clicked in order to arrive at the page you are on. Click Users 
and Groups in the breadcrumb trail. 

9. Specify group memberships for the rest of the users you created in 
the domain by following steps 1-6 again and using the following user 
name and available parent group names in steps 1 and 3.

• User dm belongs to the parent groups esp_data_manager and 
esp_consumer.
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• User da belongs to the parent groups esp_data_analyst and 
esp_consumer.

• User consumer belongs to the parent group esp_consumer.

• User public belongs to the parent group esp_anonymous.

Create Roles and Specify Role Membership for Groups and Users

1. Find Security Realms in the Domain Structure pane on the left of 
the page and click it.

2. In the grid on the middle of the page, click myrealm.

3. Click the Roles and Policies tab.

4. In the Roles table on the Realm Roles sub tab, expand the Global 
Roles node by clicking the plus sign next to it.

5. Click the word Roles in the Global Roles node.

6. Click New.

7. Type esp_administrator in the Name box.

8. Leave the option XACMLRoleMapper selected in the Provider 
box. 

9. Click OK.

10. Click esp_administrator in the Global Roles grid.

11. Click the Add Conditions button located in the Role Conditions 
section.

12. Select Group in Predicate List and click Next.

13. Type esp_administrator in the Group Argument Name box and 
click Add.

14. Click Finish.

15. Click the Add Conditions button located in the Role Conditions 
section.

16. Select User in Predicate List and click Next.

17. Type admin in the User Argument Name box and click Add.

18. Click Finish.



WebLogic 68

19. In the dropdown box between the User and Group labels, select 
And.

20. Click Save.

21. Click Global Roles in the breadcrumb trail at the top of the page.

22. Specify the rest of the role memberships by following steps 6-21 
again and using the following roles in steps 7 and 10, groups in step 
13, and users in step 17.

• The role esp_data_manager has the esp_data_manager 
group and dm user as its members.

• The role esp_data_analyst has the esp_data_analyst group 
and da user as its members.

Now, specify the role memberships for the esp_consumer group. There 
are more members in this role, so there are a few extra steps you will 
need to follow.

1. Click New.

2. Type esp_consumer in the Name box.

3. Leave the option XACMLRoleMapper selected in the Provider 
box.

4. Click OK.

5. Click esp_consumer in the Global Roles grid.

6. Click the Add Conditions button located in the role conditions 
section.

7. Select Group in Predicate List and click Next.

8. Type esp_consumer in the Group Argument Name box and 
click Add.

9. Click Finish.

10. Click the Add Conditions button located in the Role 
Conditions section.

11. Select User in Predicate List and click Next.

12. Type admin in the User Argument Name box and click Add.

13. Type dm in the User Argument Name box and click Add.

14. Type da in the User Argument Name box and click Add.
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15. Type consumer in the User Argument Name box and click 
Add.

16. Click Finish.

17. In the dropdown box between the User and Group labels, 
select And.

After you have finished creating the roles and specifying their 
conditions, the WebLogic application server is configured to work with 
ERDAS APOLLO Server (Advanced/Professional).

Configuration - 
Essentials-SDI

Configuring WebLogic for ERDAS APOLLO Server (Essentials-SDI) 
consists of the following basic steps:

• Create a new WebLogic domain in the WebLogic configuration 
wizard tool.

• Change the default memory settings.

• Configure the security.

To open the WebLogic Configuration Wizard:

1. Click the Windows Start button.

2. Click All Programs.

3. Select ORACLE > WebLogic > Tools > Configuration 
Wizard.

Create the Domain 1. Choose Create a new WebLogic domain and click Next.

2. Choose Generate a domain configured automatically to 
support the following products and click Next.

NOTE:  It is not necessary to activate WebLogic Workshop.

3. Specify a password for the WebLogic administrator user.

4. In the next step, you are asked to specify a domain startup mode 
and the folder where the JDK is installed.
Choose the domain startup mode that best fits your need and make 
sure to choose the SUN JDK 1.6 version.
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5. The next step asks you to customize options for the domain. 
If you are satisfied with the default options, leave the default option 
of No selected and click Next.
If you need to change the WebLogic port number to avoid conflicts 
with another application, then select Yes and click Next.
If you select Yes because you need to change the WebLogic port 
number, the wizard will show you four more panels. 
The first of these additional panels will appear after you click Next. 
In this screen, you should type your new port number in the Listen 
Port box. Your network administrator can help you find a new 
number that is not being used already. After you type in your new 
port number, click Next.
The second additional panel shows each instance of WebLogic that 
you have installed on this computer already. The instance of 
WebLogic that you are currently installing will not appear in this 
screen. You can click Next to advance past this panel.
The third additional panel shows information about configuring 
machines. Click Next to advance past this panel.
The final additional panel shows some review information. Click 
Next to advance past this panel and continue with the next 
numbered step in this guide.

NOTE:  The WebLogic port number can also be changed after the 
installation process.

If you want to change the WebLogic port number after installation:

• Open the directory 
C:\ORACLE\Middleware\user_projects\domains\apollo_do
main\config

• Copy the config.xml file and paste it in the same directory 
so you have a backup copy of the working config.xml file.

• Highlight the original file and right-click it.

• Select Open With… in the menu.

• In the Programs list in the Open With dialog, select 
NotePad. 

• Click OK.
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• If you used the default port number at install time, you will be 
able to find a block of text in your file that looks similar to the 
following (the line in blue will only be there if you tried to set 
the port number to something other than the default value of 
7001 when you first installed WebLogic):

• To change the port number, add the line with the listen-port 
tags if it is not there already and type the port number you 
want to use between the tags.

• Save this file and close it.

6. The final panel asks you to specify the name and location for the 
domain. Click Create when you are finished.

7. The configuration wizard notifies you when the domain has been 
created successfully. Click Done to close the wizard.

Configure Security 1. The role esp_administrator needs to be assigned to the users that 
need to use the ERDAS APOLLO Data Manager to interact with an 
ERDAS APOLLO Server. On WebLogic, go first to the admin 
console (http://<hostname>:<portnumber>/console) and connect 
using the WebLogic administrator user that was created with the 
domain).

2. Then, create a user by following these steps:

• In the domain structure tab on the left, choose Security 
Realms.

• Choose the realm that was used to initialize the security 
(myrealm by default).

• Choose the Users and Groups tab.

• Click on the New button and specify the information of the user 
you want to create. Click on the OK button.

3. Once the user has been created, the next step is to register the 
esp_administrator role and to assign it to the user:

• In the domain structure tab on the left, choose Security 
Realms.

<server>
<name>AdminServer</name>
<listen-port>1234</listen-port>
<listen-address></listen-address>

</server>
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• Choose the realm that was used to initialize the security 
(myrealm by default).

• Choose the Roles and Policies tab.

• Expand the Global Roles node and click on Roles.

• Click on the New button and specify esp_administrator as the 
role name. Click on the OK button.

• Click on the esp_administrator role.

• On the role Roles conditions row, click on the Add conditions 
button

• In the predicates list, choose User then click on the Next  
button.

• In the User Argument Name field, specify the name of the user 
that was created, then click on the Add button.

• Once this is done, click on the Finish button.

• Click on the Save button to apply your changes.

4. At this point, ERDAS APOLLO Server is ready to be deployed.
The deployment instructions can be found in the ERDAS APOLLO 
Server installation section.

Deployment After you install and configure WebLogic, following these instructions to 
deploy ERDAS APOLLO Server (Advantage/Professional) on 
WebLogic. 

Set Environment Variable Follow these instructions to place a line in the startup script of the 
application server that creates an environment variable called 
IMAGINE_HOME_PATH with the value SET.

1. Open the folder 
C:\oracle\middleware\user_projects\domains\apollo_doma
in\bin

2. Right-click the file startWebLogic.cmd and select Edit in the 
menu.

3. Find the line that says

for %%i in ("%DOMAIN_HOME%") do set DOMAIN_HOME=%%~fsi
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4. Just above that line, add the following new line:

Be sure to change <APOLLO_HOME> to the full path of the directory 
where you installed ERDAS APOLLO Server. Also note that the 
command is on different lines here, but should be on a single line in 
your file.

5. Just after the line you just added, but before the line

add the line

Be sure to change <APOLLO_HOME> to the full path of the directory where 
you installed ERDAS APOLLO Server. Also note that the command is 
on different lines here, but should be on a single line in your file.

6. Save the file and close it.

Increase Memory 
Settings

Increase the memory settings for WebLogic and set the startup script 
for FME. 

1. Access the file: 
<WebLogic_HOME>\user_projects\domains\apollo_domain\bin\s
etDomainEnv.cmd 

2. Find the line: 
set MEM_PERM_SIZE_32BIT=-XX:PermSize=48m 

3. Change the PermSize to 96.
set MEM_PERM_SIZE_32BIT=-XX:PermSize=96m

4. Find the line:
set MEM_MAX_PERM_SIZE_32BIT=-XX:MaxPermSize=128m

5. Change the MaxPermSize to 256.
set MEM_MAX_PERM_SIZE_32BIT=-XX:MaxPermSize=256m

set LOG4J_CONFIG_FILE=<APOLLO_HOME>\dist\weblogic\log4jConfig.xml

for %%i in ("%DOMAIN_HOME%") do set DOMAIN_HOME=%%~fsi

set JAVA_OPTIONS=%JAVA_OPTIONS%-Djava.security.auth.login.config
=<APOLLO_HOME>\dist\weblogic\auth.conf
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6. Find the following
if "%JAVA_VENDOR%"=="Sun"

set WLS_MEM_ARGS_64BIT=-Xms256m -Xmx512m

set WLS_MEM_ARGS_32BIT=-Xms256m -Xmx512m

else

set WLS_MEM_ARGS_64BIT=-Xms512m -Xmx512m

set WLS_MEM_ARGS_32BIT=-Xms512m -Xmx512m

7. Increase the Xms values as shown.
if "%JAVA_VENDOR%"=="Sun"

set WLS_MEM_ARGS_64BIT=-Xms1024m -Xmx4096m
set WLS_MEM_ARGS_32BIT=-Xms512m -Xmx1024m

else

set WLS_MEM_ARGS_64BIT=-Xms1024m -Xmx4096m
set WLS_MEM_ARGS_32BIT=-Xms512m -Xmx1024m

8. Add the following lines to the end of the file:
@REM Set APOLLO FIO

set PATH=<APOLLO_HOME>\tools\native\fme;%PATH%

set IMAGINE_HOME_PATH=SET

Bundled JDK Follow these instructions to use ERDAS APOLLO’s bundled JDK with 
WebLogic.

1. Open the file named setDomainEnv.cmd under <Your DOMAINs 
folder>/<your domain name>/bin

2. Look for the command: set SUN_JAVA_HOME= whatever ..

3. Add a Comment line as follows.
@REM set SUN_JAVA_HOME=C:\Oracle\Middleware\jdk160_18

4. After the comment line, add the following.
set SUN_JAVA_HOME=<APOLLO_HOME>\tools\jdk



75 WebLogic

5. Look for the following paragraph.
if "%JAVA_VENDOR%"=="Oracle"

set JAVA_HOME=%BEA_JAVA_HOME%

else (

if "%JAVA_VENDOR%"=="Sun"

set JAVA_HOME=%SUN_JAVA_HOME%

else

set JAVA_VENDOR=Sun

set JAVA_HOME=C:\Oracle\Middleware\jdk160_18

6. Look for the following line in the paragraph.
set JAVA_HOME=C:\Oracle\Middleware\jdk160_18

7. Comment it out as follows.
@REM set JAVA_HOME=C:\Oracle\Middleware\jdk160_18

8. Add the following  line below the commented-out line.
set JAVA_HOME=<APOLLO_HOME>\tools\jdk

Restart WebLogic After you edit the startWebLogic.cmd file, restart WebLogic.

1. Click the Windows Start button.

2. Click All Programs.

3. Select Oracle > WebLogic > User Projects > apollo_domain > 
Start Admin Server for WebLogic Server Domain.

4. A command line window will open.
Enter the user name weblogic and the password weblogic1 to log 
in to the domain.

5. You will know the server has started successfully when the text 
stops scrolling in the window and you see the notice “Server started 
in RUNNING mode”. 

Do not close the command line window that opened while you were 
starting WebLogic.

Open Administration 
Console 

1. Launch the WebLogic Server Administration Console by opening 
your browser and typing http://localhost:7001/console in the 
address bar.

2. Click Deployments in the Domain Structure box on the left of the 
page.
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3. Click Install.

4. Navigate to the <APOLLO_HOME>\dist\weblogic folder and click 
the radio button next to erdas-apollo.ear in the list of files in that 
folder.

5. Click Next.

6. The next step asks you to choose the targeting style and has the 
default option as Install this deployment as an application. 
Accept this option and click Next.

7. On the Optional Settings page, find the Security section and select 
the option that says, "Custom Roles: Use roles that are defined 
in the Administration Console; use policies that are defined in 
the deployment descriptor."

8. Click Finish.

9. Check the box to the left of erdas-apollo.ear in the Deployments 
table.

10. Click the Start button. A menu will appear below the button. Select 
Servicing all requests in the menu.

11. Click Yes to continue starting the deployment.

12. Click startRunning in the State field for the erdas-apollo.ear entry in 
the Deployments table. It will change to Active. Erdas-apollo.ear 
appears in the Deployments table.
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ERDAS APOLLO Feature Interoperability
ERDAS APOLLO Feature Interoperability is an add-on module included 
with the ERDAS APOLLO installation that lets you create a vector 
service provider (which includes WFS and WMS interfaces) that is 
attached to data in the V7 DGN and V8 DGN data formats. 

ERDAS Feature Interoperability includes the FME Universal Viewer 
and FME Workbench. FME Universal Viewer lets you view ERDAS 
APOLLO data in any of the formats supported by FME. FME 
Workbench allows you to translate ERDAS APOLLO data. 

ERDAS APOLLO Feature Interoperability, is compatible with ERDAS 
APOLLO version 10.1 or higher and Windows operating system.

ERDAS APOLLO Feature Interoperability requires a license separate 
from ERDAS APOLLO. 

Refer to the ERDAS-Net Licensing chapter for more information.

If you need additional assistance with licensing, e-mail 
teamlicensing@erdas.com

Launch both applications from the MS Start menu under the ERDAS 
APOLLO category.

Safe Software, the makers of the FME Workbench, provides online 
documentation for the application.

teamlicensing@erdas.com
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Troubleshooting Your Installation
The ERDAS APOLLO system is designed to work with certain 
commonly used operating systems, third-party software packages, and 
network configurations and it is tested rigorously to make sure that its 
standard configuration options allow it to work well with them.  It is also 
designed to be flexible enough so that it can work with many others that 
are not so commonly used.

However, due to the variety of ways in which you can configure an 
operating system or network, and the many other applications you can 
run alongside ERDAS APOLLO, there are occasions when you may 
need to make some slight changes to something on your computer 
system in order for everything to work well together.

I just tried to connect my ERDAS APOLLO Data Manager to my ERDAS APOLLO 
Server for the first time. 

There are a few different things that can cause this to appear.

First, check to make sure that you have installed the ERDAS-Net 
License Server and that you have it configured with valid licenses. 
There is a guide for that product that explains how to install and use it. 
If you have installed it correctly and are using it correctly, you should 
then check to make sure you have supplied all of the proper licenses.

If you are still having the problem after you have made sure the license 
server is running and has the correct licenses, you need to examine the 
application server.

If you are using JBoss, the ERDAS APOLLO installer placed it on your 
system, but you will need to start the application server.

To start your JBoss application server:

1. Open the Control Panel.

2. Select Administrative Tools > Services

3. Find ERDAS APOLLO Apache Web Server in the grid, right-
click it, and select Start in the menu.

If you do not see JBoss in the list of services, you need to install JBoss 
as a Windows Service and then start it.
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To install ERDAS APOLLO Server as a Windows service and start the 
service:

1. Open a command line window.

2. Navigate to the <APOLLO_HOME>/tools/scripts/ directory.

3. At the prompt, type uninstall_service.bat and press Enter.

4. After that command finishes, type install_service.bat at the 
prompt.

5. Start the ERDAS APOLLO Apache Web Server service in the 
Windows Services dialog.

If you are still having the issue, then Windows may have allowed 
another application to use port number 1099, which is the one that 
JBoss needs.

To see if another application is using JBoss’ port 1099:

1. Open a command line window.

2. At the prompt, type netstat -anb |find "LISTENING" and press 
Enter. 
You may not see anything right away, because It often takes a little 
while for the computer to complete this task.
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When it finishes, it will look similar to what you see in the 
following figure.

3. In the second column from the left, find the entry that has 1099 at 
the end of it. 

NOTE:  in the figure above, the entry is in the seventh row and 
looks like 0.0.0.0:1099.

Locate the corresponding process ID in the last column of that row. 

NOTE:  In the figure above, it is 3204.

4. In the second column from the left, find the entry that has your 
ERDAS APOLLO Server port number at the end of it. Usually, the 
port number is 8080. 

NOTE:  in the figure above, entry is in the eighteenth row and looks 
like 0.0.0.0:8080.

Locate the corresponding process ID in the last column of that row. 

NOTE:  In the figure above, it is 3204.
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The process ID numbers that you found in steps 3 and 4 should be the 
same. If they are not, then you need to set 1099 as a reserved port in 
your Windows registry so that it will not allow other applications to use it.

To set 1099 as a reserved port in Microsoft Windows:

1. Open the Windows Registry editor.

a. Click the Windows Start button

b. Click Run... in the Start menu.

c. Type regedt32 in the box that appears.

d. Click OK on the box.
The Registry Editor opens.

2. In the panel on the left side of the Registry Editor, you need to open 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\
Tcpip\Parameters. To do this:

a. Open the HKEY_LOCAL_MACHINE node by clicking the 
plus sign next to it.

b. Open the System node by clicking the plus sign next to it.

c. Open the CurrentControlSet node by clicking the plus sign 
next to it.

d. Open the Services node by clicking the plus sign next to it.
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e. Open the Tcpip node by clicking the plus sign next to it.

f. Click on the word Parameters inside the Tcpip node.
Your Registry Editor should look similar to the figure below. 
Notice the path in the status bar.

3. Select Edit > New > Multi-String Value in the main Registry Editor 
menu.
A value named New Value #1 appears at the bottom of the panel 
on the right side of the Registry Editor.

4. Right-click the New Value #1 entry and select Rename on the menu 
that appears.

5. Type ReservedPorts and press Enter on the keyboard.

6. Double-click the ReservedPorts value.
The Edit Multi-String dialog box opens.

7. Type 1099-1099 in the Value data box and click OK.

8. Exit the Registry Editor.

9. Reboot the computer.

Microsoft Windows will now keep the 1099 port available so that JBoss 
will be free to use that port when it needs it.
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If you are still having the problem after you have checked the ERDAS-
Net License Server, made sure that the JBoss application server is 
started, and set 1099 as a reserved port, please contact ERDAS. Your 
technical support representative will be happy to provide you with 
further assistance.

When I try to use the Data Manager to crawl National Imagery Transmission Format 
(NITF) data so that I can add it to my catalog, the crawling job fails.

It’s possible that one or more of the NITF datasets that you are trying to 
crawl doesn’t conform completely to the official NITF standard, and is 
considered invalid.

To make sure that your data is fully compliant with the official NITF 
standard, you can use the CIVA tool, which is available from the Joint 
Interoperability Test Command’s NITFS Compliance Test Facility. 
Information about the CIVA tool and how to get it can be found at 
http://www.gwg.nga.mil/ntb/baseline/software/jitctest.html.

http://www.gwg.nga.mil/ntb/baseline/software/jitctest.html
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Glossary
The glossary terms defined in this guide are those used in all ERDAS 
APOLLO guides.

A

Ant
Apache Ant is a Java-based build tool from the Jakarta Project.

Applet
A component that typically executes in a web browser, but can also 
be executed in a variety of other applications or devices that support 
the applet application model.

Area
Area is defined by a two dimensional (area) feature represented by 
a line that closes on itself to form a boundary.

B

Bounding Box
A bounding box is defined as the extent of the geographic area that 
you wish to display by using coordinate values of the chosen Spatial 
Reference System.

C

Connector
A class of connection to a specific type of data source.

Coordinate
One of a sequence of N numbers designating the position of a point 
in N-dimensional space. In a coordinate reference system, the 
coordinate numbers must be qualified by units.

Coordinate System
Set of rules for specifying how coordinates are to be assigned to 
points. One coordinate system may be used in many coordinate 
reference systems.

http://jakarta.apache.org/
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Coordinate Transformation
Computational process of converting a position given in one 
coordinate reference system into the corresponding position in 
another coordinate reference system.

D

Dimension
A OGC-WMS 1.1.1 mechanism that allows the application of a Filter 
in a GetMap request.

E

Elevation
In the context of the OGC-WMS 1.1.1 interfaces, Elevation is a 
parameter that can be given in a GetMap request. It represents a 
given type of Dimension, a concept also explained in that 
specification.

Ellipsoidal
An ellipsoidal surface is a geometric surface, all of whose plane 
sections are either ellipses or circles.

EPSG
EPSG is defined as a type of geographic projection. The EPSG 
namespace makes use of the European Petroleum Survey Group 
tables, which define numeric identifiers (the EPSG "SRS code," 
corresponding to the field "COORD_REF_SYS_CODE" in the 
EPSG database) for many common projections and which 
associate projection or coordinate metadata (such as measurement 
units or central meridian) for each identifier.

F

Feature (geographic)
Features are "abstractions of a real world phenomenon; it is a 
geographic feature if it is associated with a location relative to the 
Earth.”

Feature Types
The number and kind of properties a feature has describes its 
feature type.
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Feature Mapping
The mapping is the configuration that describes the link between the 
FeatureType definition and the objects returned by the underlying 
engine. The mapping document associated with a WFS service 
presents the necessary information for the WFS to convert client 
requests to queries understood by the data server. It also converts 
the result into a compliant collection of features. So, it makes the 
link between the internal data structure and the published 
information.

Feature Schema
The XML Schema associated with a WFS service gives the GML 
Schema (structure) needed by the WFS to expose its feature types. 
The schema is the type descriptions structure for each feature type 
and for each property of those feature types.

G

Get
A GET request is an HTTP request for exchanging information with 
a server.

Geographic Information
Geographic Information is data that is referenced to locations on the 
earth's surface, such as digital maps and sample locations.

Geographic Information System
A Geographic Information System is an organized collection of 
computer hardware, software, geographic data, and personal 
information designed to efficiently capture, store, update, 
manipulate, analyze & display all forms of geographically 
referenced info.

GML
GML is an open, non-proprietary language used to created geo-
spatial objects for the purpose of data sharing. GML also serves as 
a data transport for geo-spatial objects as well as exists as a means 
for describing geo-spatial Web services.
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I

ISO
The International Organization for Standardization (ISO) is a 
worldwide federation of national standards bodies from more than 
140 countries, one from each country. ISO is a non-governmental 
organization established in 1947. The mission of ISO is to promote 
the development of standardization and related activities in the 
world with a view to facilitating the international exchange of goods 
and services, and to developing cooperation in the spheres of 
intellectual, scientific, technological and economic activity. ISO's 
work results in international agreements which are published as 
International Standards.

Interoperability
Interoperability is the ability of systems, units, or forces to provide 
services to and accept services from other systems, units or forces 
and to use the services so exchanged to enable them to operate 
effectively together. For example, interoperability describes the 
condition achieved among communications-electronics systems or 
items of communications-electronics equipment when information 
or services can be exchanged directly and satisfactorily between 
them and/or their users. The degree of interoperability should be 
defined when referring to specific cases. Interoperability is the 
ability of a system or a product to work with other systems or 
products without special effort on the part of the customer. 
Interoperability becomes a quality of increasing importance for 
information technology products as the concept that "The network 
is the computer" becomes a reality.

J

JDBC
Java Database Connection. The Java interfaces to database 
connectivity.

Java Virtual Machine
A software computer that interprets and executes the byte codes in 
Java class files like a microprocessor would execute machine code.
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L

Layer
A layer is a usable subdivision of a dataset, generally containing 
objects of certain classes, for example rivers, roads or geology.

M

Metadata
Metadata is often textual descriptive data about GI or other types of 
data. This information will often include some of the following: What 
it is about? Where it is to be found? Who can access it? In what 
format it is available? What is the quality of the data for a specified 
purpose? What spatial location does it cover and over what time 
period? When and where the data were collected, and by whom and 
for what purposes the data have been used?

O

Open Geospatial Consortium (OGC)
OGC is an international industry consortium of more than 230 
companies, government agencies and universities participating in a 
consensus process to develop publicly available geoprocessing 
specifications.

P

Point
A point is a zero-dimensional abstraction of an object represented 
by a single X,Y coordinate. A point normally represents a 
geographic feature too small to be displayed as a line or area; for 
example, the location of a building location on a small-scale map, or 
the location of a service cover on a medium scale map.

Post
Post is an HTTP request for exchanging information with a server.

Provider
An instance of a connector, for a given data source.
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R

Raster
Raster defines a method for the storage, processing and display of 
spatial data. Each given area is divided into rows and columns, 
which form a regular grid structure. Each cell must be rectangular in 
shape, although not necessarily square. Each cell within this matrix 
contains an attribute value as well as location coordinates. The 
spatial location of each cell is implicitly contained within the ordering 
of the matrix, unlike a vector structure which stores topology 
explicitly. Areas containing the same attribute value are recognized 
as such, however, raster structures cannot identify the boundaries 
of such areas as polygons. Also raster structures may lead to 
increased storage in certain situations, since they store each cell in 
the matrix regardless of whether it is a feature or simply 'empty' 
space.

S

Scalable Vector Graphics(SVG)
SVG is an XML grammar for stylable graphics.

Service Oriented Architecture
A service-oriented architecture is a way of connecting applications 
across a network via a common communications protocol. In 
theory, this lets developers treat applications as network services 
that can be chained together to create a complex business 
processes more quickly. 

Servlet Engine
An environment written by a Web server vendor in accordance with 
this specification that allows servlets to run with a particular Web 
server.

Shape File
A shapefile stores non-topological geometry and attribute 
information for the spatial features in a data set. The geometry for a 
feature is stored as a shape comprising a set of vector coordinates.

Simple Features
Simple Features are in essence a "Lite" version of the ISO model 
corresponding to the data model required to support basic GIS 
systems.
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Spatial Reference System (SRS)
A SRS is a reference system provides a scale of measurement for 
assigning values “to a location, time or other descriptive quantity or 
quality” according to OGC.

Styled Layer Descriptor (SLD)
SLD is a styling language that the client and the server both 
understand, used to portray the output of the WMS, WFS and Web 
Coverage services.

Stack Trace
A list of what methods were called, in what order, to invoke the 
method in which the exception occurred (called a "stack trace" 
because it prints out a stack of method names).

Struts (Apache Web Application Framework)
Struts encourages application architectures based on the JSP 
Model 2 approach, a variation of the classic Model-View-Controller 
(MVC) design paradigm.

Swing, the Java Foundation Classes
The Java Foundation Classes (JFC) are a set of Java class libraries 
provided as part of J2SE™ to support building graphics user 
interfaces (GUI) and graphics functionality for Java technology-
based client applications.

U

Usability
Usability is defined by the ease with which a user can learn to 
operate, prepare inputs for and interpret outputs of a system or 
component.
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V

Vector
Vector defines one method of data type, used to store spatial data. 
Vector data is comprised of lines or arcs, defined by beginning and 
end points, which meet at nodes. The locations of these nodes and 
the topological structure are usually stored explicitly. Features are 
defined by their boundaries only and curved lines are represented 
as a series of connecting arcs. Vector storage involves the storage 
of explicit topology, which raises overheads, however it only stores 
those points which define a feature and all space outside these 
features is 'non-existent.'

W

WAR file
Web Archive file: a type of jar file used by servlets.

Webapp
Webapp or Web Application: Groups of server-side Web resources 
that make up an interactive online application. The Web resources 
include Java servlets, JSPs, static documents (such as HTML 
documents), and applets that can be deployed in a client Web 
browser. Web applications must run in the context of an Application 
server or Servlet Engine.

WFS
A WMS is an OGC specification for a Web Feature Server.

WMS
A WMS is an OGC specification for a Web Map Server.

X

XML Schema
A language to express XML types. See 
http://www.w3.org/XML/Schema.

http://www.w3.org/XML/Schema
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